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About this Guide
The BI Portal Installation Guide provides information about installing and 
configuring Peregrine BI Portal and the related third-party software. 

This guide details how to install BI Portal Real Estate on the OAA platform 
and includes the following chapters:

Chapter 1, BIPortal component overview

Chapter 2, Preparing for the BI Portal Installation

Chapter 3, Installing on Windows

Chapter 4, Installing on UNIX

Chapter 5, Load Balancing

Chapter 6, Configuring Software Components

Appendix A, Troubleshooting the installation
About this Guide  9



BI Portal
Using this Guide

This guide is designed to be used in sequence. Beginning with Chapter 1 and 
continuing through the other chapters, you will install and configure the BI 
Portal software and all related third-party software.

Important: It is important that you perform the installation process 
according to the sequence presented.

Prior to using this guide, you should read the following sections:

Related Documentation on page 10

Documentation Conventions on page 11

Contacting Peregrine Systems on page 11

Related Documentation

In addition to this guide, the following documentation is available for the BI 
Portal product:

This manual… Provides information on…

BI Portal Administration 
Guide

Provides an overview of the OAA platform. 
Describes how you customize the BI Portal and the 
OAA Administration module. Provides 
information about security in BI Portal, and RDS 
Universe administration.

BI Portal User’s Guide Helps you get started with Peregrine BI Portal and 
use it to generate queries and reports.

BI Portal Release Notes Includes enhancements and known issues for the 
OAA platform and for BI Portal.

 OAA Platform Administrator’s 
Guide

Describes installing and maintaining systems that 
use the Peregrine OAA platform. 

WebIntelligence User’s Guide Describes how to use WebIntelligence for building 
and running queries, reporting, and analysis.

Business Objects Installation 
and Configuration Guide for 
Windows

Describes how to install and configure Business 
Objects products under Windows.
10  About this Guide 
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Documentation Conventions

 The following typographical conventions are used in this guide.

Contacting Peregrine Systems

For further information and assistance with this release, you can download 
documentation or schedule training.

Customer Support
For further information and assistance, contact Peregrine Systems’ 
Customer Support at the Peregrine CenterPoint Web site.

To contact customer support:

1 In a browser, navigate to http://support.peregrine.com

2 Log in with your user name and password.

3 Follow the directions on the site to find your answer. The first place to search 
is the KnowledgeBase, which contains informational articles about all 
categories of Peregrine products.

4 If the KnowledgeBase does not contain an article that addresses your 
concerns, you can search for information by product; search discussion 
forums; and search for product downloads.

Text Formatting Meaning

italics Text that acts as a placeholder for information you will 
provide. 

Italics are also used for book titles and for emphasis.

sans serif font Text that you type. Examples are filenames and URLs.

This font is also used for samples of code and commands.

bold Names of user interface elements. Examples are menu 
items and names (select Open from the File menu), 
button names (click Accept), and names of screens or 
dialogs (the Server Manager window).
Documentation Conventions  11
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Documentation Web site
For a complete listing of current BI Portal documentation, see the 
Documentation pages on the Peregrine Customer Support Web.

To view the document listing:

1 In a browser, navigate to http://support.peregrine.com.

2 Log in with your login user name and password.

3 Click either Documentation or Release Notes at the top of the page.

4 Click the BI Portal link.

5 Click a product version link to display a list of documents that are available 
for that version of BI Portal.

6 Documents may be available in multiple languages. Click the Download 
button to download the PDF file in the language you prefer.

You can view PDF files using Acrobat Reader, which is available on the 
Customer Support Web site and through Adobe at http://www.adobe.com. 

Important: Release Notes for this product are continually updated after each 
release of the product. Ensure that you have the most current 
version of the Release Notes.

Education Services Web Site
Peregrine Systems offers classroom training anywhere in the world, as well as 
“at your desk” training via the Internet. For a complete listing of Peregrine’s 
training courses, refer to the following web site:

http://www.peregrine.com/education

You can also call Peregrine Education Services at +1 858.794.5009.
12  About this Guide 
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CHAPTER
1 B
IPortal component overview
BI Portal uses software components that can be installed in a variety of 
hardware configurations. 

BI Portal architecture

BI Portal uses the following components:

Component Description

BI Portal A Web application that you use to create and edit queries 
and reports. For more information about using BI Portal, 
see the BI Portal User’s Guide.

BI Reporting Server Deploys the Peregrine version of the Business Objects 
Repository. In addition, the WebIntelligence Reporting 
Server must be installed on the BI Reporting Server. 
Publishes Peregrine content meta-data such as 
ServiceCenter meta-data. The rds universe is stored on 
the BI Reporting Server. 

For more information about universes, see the BI Portal 
User’s Guide section Universes, classes, and objects.

Business Objects 
Repository

An RDBMS that contains the Business Objects Security, 
Document, and Universe domains. Stores all data sets and 
documents. 

Reporting Data Store 
(RDS)

Stores ServiceCenter reporting data. Storing data on the 
RDS reduces the performance impact on your 
ServiceCenter database of running queries and reports.
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Connect-It Used to establish a connection between the RDS and the 
ServiceCenter database.

ServiceCenter database The ServiceCenter database is a repository for all the data 
stored in your ServiceCenter implementation. The 
ServiceCenter database is the P4 database by default; 
however, you can also use one of the following RDBMS 
products: Oracle, SQL Server, or DB2 for Windows.

ServiceCenter 
application

The ServiceCenter application is the interface where you 
perform ServiceCenter tasks.

Application server The default application server that is installed with the BI 
Portal typical installation is Tomcat. You can use another 
application server if you prefer. To use an application 
server other than Tomcat, you first perform a custom 
installation and then manually configure the BI Portal 
components.

Web server The default Web server that is installed with the BI Portal 
typical installation is Apache. You can use another Web 
server if you prefer. To use a Web server other than 
Apache, you first perform a custom installation and then 
manually configure the BI Portal components.

Component Description
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The following diagram depicts the BI Portal architecture:
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2 P
reparing for the BI Portal Installation
The chapter includes all the software installation and configuration processes 
that are required prior to installing and running BI Portal.

Topics in this chapter include:

Hardware requirements on page 18

Software and platform requirements on page 18

Software installation and configuration requirements on page 18

Configuring the database on page 19

Install the database client on each server machine on page 29

Create a Windows user named BO_User on page 31

Install Business Objects and configure it for BI Portal on page 33

Install Connect-It on page 41

Check ServiceCenter installation on page 44
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Hardware requirements

The following items are the minimum hardware requirements for BI Portal:

Software and platform requirements

For complete information about the requisite software that must be installed 
and configured before you install BI Portal, see the BI Portal Compatibility 
Matrix at support.peregrine.com.

Software installation and configuration requirements

Before you perform a typical or custom BI Portal installation, in either a 
single-server or multi-server configuration, you need to make the following 
preparations:

Install and configure the database servers that you will use.

Install the database server on a separate server machine from those on 
which you will install BI Portal components. 

Install the database client you intend to use, on each server machine on 
which you will install BI Portal components. See the section Install the 
database client on each server machine on page 29.

Create a Windows user named BO_User on the server machine where the 
BI Portal client will reside. See the section Create a Windows user named 
BO_User on page 31 for more information.

Make sure that Business Objects is installed on the same server machine as 
the Reporting Server. Then create a Business Objects user who has 
permission to log in as administrator. See the section Install Business 
Objects and configure it for BI Portal on page 33.

Item Minimum Requirement

Processor Pentium 1 GHz or faster

RAM 512 MB minimum on each server machine. More RAM may be 
required if you will be running multiple instances of the 
application server, or if you intend to use very large databases.

Disk Space 100 MB minimum available on web server
615 MB minimum available on Oracle servers
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Install Connect-It on the same server machine on which you plan to install 
the RDS. The Connect-It installation CD is included with BI Portal. See 
the section Install Connect-It on page 41 for installation instructions.

ServiceCenter should be installed on a separate server machine from those 
on which you will install BI Portal components. To check your 
ServiceCenter installation, refer to the section Check ServiceCenter 
installation on page 44.

Configuring the database

This section describes the steps you take to set up your database server to 
function with BI Portal. There are three sections, one for each type of 
database that BI Portal is designed to use: Oracle, DB2 for Windows, and 
SQL Server.

Configuring Oracle for BI Portal
BI Portal 5.0 uses Oracle as the default database server. This section explains 
how to set up Oracle in preparation for installing BI Portal.

Note: The SQL commands shown below are examples only. The actual 
commands you use may differ.

Installing Oracle
Install the Oracle server, version 8.17 or 9i, from the Oracle CD.

If you are installing Oracle for the first time on the server, set both the 
database name and the database instance name to the same name, such as 
ORCL.

Note: Record the following information about your Oracle installation: the 
database name (either the global name or the service name) and the 
database SID (instance name).

Creating the tablespace and the BI Portal user
The tablespace is the storage location for the BI Portal databases. You create 
two tablespaces, called BI_REPO and RDS.
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Creating the tablespace

Note: The BI_REPO and RDS tablespaces requires 615 MB of free space 
each. Make sure your hard drive has 1230 MB of free space.

To create the tablespace:

1 On the database server, go the Start menu, select Programs > Oracle > 
OracleHome8i > Database Administration > SQLPlus Worksheet.

Note: Do not use SQLPlus. Use SQLPlus Worksheet.

2 Log in as System, using manager as the password, or log in as the super user 
for your system.

Note: Consult your database administrator if you need help logging in.

3 Type a script such as the following, which creates a tablespace for BI_REPO. 

CREATE TABLESPACE BI_REPO DATAFILE 
‘C:\ORACLE\Ora81\database\BI_REPO.ora’ 

SIZE 600M

AUTOEXTEND ON NEXT 1M MAXSIZE UNLIMITED;
commit;

Note: When creating the RDS tablespace, replace “BI_REPO” with “RDS” 
throughout. 

If necessary, edit the string to reference the drive and directory where Oracle 
is installed. The path you enter, such as C:\ORACLE\ORADATA\ORCL, must 
exist on the system.

4 Click the lightning icon to run the script.

The script may take up to three minutes to run. When the following lines 
appear, the script is finished:

Tablespace created.
Commit complete.

5 Look in the lower pane for any errors messages. If the previous lines appeared 
and there are no errors, go to the next section, “Creating BI Portal users.”
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Creating BI Portal users

You create four users for BI Portal: BI_REPO, BIREPO1, BIREPO1L, and 
RDS_DBA. These four users are the database administrator IDs that BI Portal 
uses to connect to the database. The following script creates a BI_REPO user 
who has “connect” and “resource” rights. (You can tailor the script as 
necessary for your system. Consult your database administrator for 
assistance.) 

“Connect” provides the following rights:

“Resource” provides these rights: 

create cluster

create procedure

create sequence

create table

create trigger

To create the BI_REPO user:

1 On the database server, from the Edit menu, click Clear All to delete the text 
in the window.

2 Type a script such as the following. Of course, when creating each of the other 
three users, BIREPO1, BIREPO1L, and RDS_DBA, replace “BE_REPO” with 
the appropriate name. 

Important: Use “password” for BI_REPO, BIREPO1, and BIREPO1L. Use 
“passw0rd” (where the sixth character is the number zero, not 
the letter “O”) when creating RDS_DBA.

create session alter session

create table create view

create synonym create sequence

create database link create cluster
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CREATE USER BI_REPO IDENTIFIED BY password
DEFAULT TABLESPACE BI_REPO
TEMPORARY TABLESPACE TEMP
QUOTA UNLIMITED ON BI_REPO
QUOTA UNLIMITED ON TEMP
PROFILE DEFAULT
ACCOUNT UNLOCK;

GRANT CONNECT TO BI_REPO WITH ADMIN OPTION;
GRANT RESOURCE TO BI_REPO WITH ADMIN OPTION;
GRANT DBA TO BI_REPO WITH ADMIN OPTION;
ALTER USER BI_REPO DEFAULT ROLE CONNECT, RESOURCE, DBA;
GRANT UNLIMITED TABLESPACE TO BI_REPO WITH ADMIN OPTION;
COMMIT;

3 Click the Lightning Bolt icon to execute the script.

4 Execute steps 2 and 3 to create users BIREPO1, BIREPO1L, and RDS_DBA.

Create a TNS name for Oracle database server
You need to create a TNS name for the Oracle database server. To do so, 
perform these steps:

1 Open the Oracle Net Configuration Assistant.

2 Choose Local Net Service Name Configuration.

3 Create a TNS name BI_REPO.

Configuring DB2 for Windows for BI Portal
To configure DB2 for BI Portal, you create default tablespaces that an 
authorized user can access.

Note: The SQL commands shown below are examples only. The actual 
commands you use may differ.

To configure DB2 for BI Portal:

1 Create four Windows local users, BI_REPO, BIREPO1, BIREPO1L, and 
RDS_DBA:

a Right-click My Computer and click Manage.

b In the Computer Management window open the Local Users and Groups 
folder, right-click Users, and click New User from the menu.
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c Use “password” for BI_REPO, BIREPO1, and BIREPO1L. Use “passw0rd” 
(where the sixth character is the number zero, not the letter “O”) when 
creating RDS_DBA.

d Either assign all four users to the Administrator group, or assign these 
users permissions in DB2.

2 Create an RDS database with the wizard using the default settings:

CREATE DATABASE RDS ON C: ALIAS RDS USING CODESET IBM-1252 
TERRITORY US COLLATE USING SYSTEM

3 Create two bufferpools for the RDS database:

CREATE Bufferpool RDS32K SIZE 250 PAGESIZE 32 K  

CREATE Bufferpool IBMDefault2 SIZE 250 PAGESIZE 32 K  

CREATE BUFFERPOOL RDSDBA SIZE 250 PAGESIZE 32K

4 Enter the following commands from the DB2 Command Window to restart 
the database and make new bufferpool active:

db2 force application all
db2stop
db2start

5 Create two tablespaces for the RDS database 

CREATE  REGULAR  TABLESPACE RDS_32K PAGESIZE 32 K  MANAGED BY 
DATABASE  USING ( FILE 'C:\DB2_DataContains\rds_32kspace' 6400) 
EXTENTSIZE 32 OVERHEAD 24.1 PREFETCHSIZE 32 TRANSFERRATE 0.9 
BUFFERPOOL RDS32K

CREATE SYSTEM TEMPORARY TABLESPACE IBMDefaultBP2 PAGESIZE 32 K 
MANAGED BY SYSTEM USING ('C:\DB2_DataContains\IBMDefaultBP2' ) 
EXTENTSIZE 32 OVERHEAD 10.5 PREFETCHSIZE 32 TRANSFERRATE 0.33 
BUFFERPOOL IBMDEFAULT2;

CREATE USER TEMPORARY TABLESPACE USERSPACE PAGESIZE 32 K 
MANAGED BY SYSTEM USING ('D:\USERTEMP' ) EXTENTSIZE 32 OVERHEAD 
10.5 PREFETCHSIZE 32 TRANSFERRATE 0.33 BUFFERPOOL RDSDB2;

6 Grant the user access to the tablespaces:

GRANT USE OF TABLESPACE RDS_32K TO USER RDS_DBA WITH GRANT 
OPTION

GRANT USE OF TABLESPACE USERSPACE TO USER RDS_DBA WITH GRANT 
OPTION
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7 Change the appheapsz parameter in the RDS database from the default, 128, 
to 256.

8 Change the logfil_siz parameter in the RDS database from the default, 250, 
to 2500.

9 Create a BI_REPO database with the wizard using the default settings:

CREATE DATABASE BI_REPO ON C: ALIAS BI_REPO USING CODESET 
IBM-1252 TERRITORY US COLLATE USING SYSTEM

10 Create a bufferpool for the BI_REPO database

CREATE BUFFERPOOL BI_REPO32K SIZE 250 PAGESIZE 32 K  

CREATE BUFFERPOOL IBMDefault2 SIZE 250 PAGESIZE 32 K  

CREATE BUFFERPOOL RDSDB2 SIZE 250 PAGESIZE 32 K

11 Enter the following commands from the DB2 command window to restart 
the database and make new bufferpool active:

db2 force application all
db2stop
db2start

12 Create a tablespace for the BI_REPO database (not using the wizard. Choose 
DMS > Advance setting for 16k buffer pool setting)

CREATE  REGULAR  TABLESPACE BI_REPO_32K PAGESIZE 32 K  MANAGED BY 
DATABASE  USING ( FILE 'C:\DB2_DataContains\bi_repo_32kspace' 6400) 
EXTENTSIZE 32 OVERHEAD 24.1 PREFETCHSIZE 32 TRANSFERRATE 0.9 
BUFFERPOOL BI_REPO32K

CREATE SYSTEM TEMPORARY TABLESPACE IBMDefaultBP2 PAGESIZE 32 K 
MANAGED BY SYSTEM USING ('C:\DB2_DataContains\IBMDefaultBP1' ) 
EXTENTSIZE 32 OVERHEAD 10.5 PREFETCHSIZE 32 TRANSFERRATE 0.33 
BUFFERPOOL IBMDEFAULT2;

CREATE USER TEMPORARY TABLESPACE USERSPACE PAGESIZE 32 K 
MANAGED BY SYSTEM USING ('D:\USERTEMP1' ) EXTENTSIZE 32 OVERHEAD 
10.5 PREFETCHSIZE 32 TRANSFERRATE 0.33 BUFFERPOOL RDSDB2;

13 Grant the new table space to the users:

GRANT USE OF TABLESPACE BI_REPO_32K TO USER BI_REPO WITH GRANT 
OPTION

GRANT USE OF TABLESPACE BI_REPO_32K TO USER BIREPO1 WITH GRANT 
OPTION
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GRANT USE OF TABLESPACE BI_REPO_32K TO USER BIREPO1L WITH GRANT 
OPTION

GRANT USE OF TABLESPACE USERSPACE TO USER BI_REPO WITH GRANT 
OPTION

GRANT USE OF TABLESPACE USERSPACE TO USER BIREPO1 WITH GRANT 
OPTION

GRANT USE OF TABLESPACE USERSPACE TO USER BIREPO1L WITH GRANT 
OPTION

14 Change the appheapsz parameter in the BI_REPO database from the default, 
128, to 256.

15 Change the logfil_siz parameter in the BI_REPO database from the default, 
250, to 2500.

Configuring SQL Server 2000 for BI Portal
This section explains how to set up SQL Server 2000 in preparation for 
installing BI Portal. Setting up SQL Server involves the following steps:

Note: The SQL commands shown below are examples only. The actual 
commands you use may differ.

Step 1 Perform the steps in the section Preparing the SQL Server 2000 for BI Portal 
that follows.

Step 2 Creating four Security Login names on page 27.

Step 3 Setting security authentication on page 28.

Important: The SQL Server database requires two sets of licenses:
SQL Server connections require four or more SQL Server 
licenses. 
Sprinta2000 driver requires three or more Sprinta2000 licenses. 

Preparing the SQL Server 2000 for BI Portal
You must successfully install the SQL Server. When installing the SQL Server, 
the default port is 1433. 

To prepare the SQL Server 2000:

1 Install SQL Server 2000.
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2 Create two databases on the database server, called BI_REPO and RDS.

a Right-click the database.

b Select New Database.

A window opens requesting the properties of the new database; for 
example, bi_repo.

Important: Make sure that the database name is alphanumeric and does not 
contain any dashes.

Note: Each database requires at least 800 MB of free space. Defragment your 
hard drive if necessary to insure that your hard drive has 1.6 GB 
contiguous free space.

Click the Data Files tab. In the Initial size (MB) field, set the database 
size to 800 (at a minimum) and set the By percent to 15. 

If the database is less than 800 MB at creation time, intermittent Update 
failure messages will occur, and the database will need to be backed up 
and dropped; a new database of size 800MB created; and the old data 
restored into the newer larger database.

Always consult your SQL Server database administrator before 
configuring the database.

Click OK.
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Creating four Security Login names
Use the SQL Server Enterprise Manager to create four login names, assign 
roles, and grant permissions. 

To create a Security Login name:

1 From the SQL Server Enterprise Manager, scroll to the Security folder and 
right-click Logins to open the SQL Server Login Properties > New Login 
dialog box.

a Type the login name BI_REPO.

b Select the SQL Server Authentication option and type password in the 
Password field.

c Select the database BI_REPO from the drop-down list. 

Note: All the login names, databases, and passwords described in this section 
must be entered exactly as shown.
Configuring the database  27



BI Portal
2 Click the Database Access tab. In the Database column click the check box to 
select bi-repo. In the Database roles section click db_owner to select it. Click 
OK.

3 In the Confirm Password dialog type password (in lower-case letters) and 
click OK.

4 Repeat step 1 through step 3 to create users called “BIREPO1” and 
“BIREPO1L” using the same password, and the same database, BI_REPO.

5 Repeat step 1 through step 3 to create a user called “RDS_DBA” and enter the 
following as the user password: passw0rd (where the sixth character is a zero, 
not the letter “O.”). Use RDS as the default database for the RDS_DBA.

Setting security authentication
After you create the Security Login name, verify that your server has Security 
set to SQL Server and Windows authentication.

To set security authentication:

1 From the SLQ Server Enterprise Manager, scroll to your server and 
right-click.
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2 Select Properties to open the SQL Server (Configure) dialog box.

3 Click the Security tab and select SQL Server and Windows.

4 Click OK.

Install the database client on each server machine

Make sure that the database client you intend to use is installed on each server 
machine. BI Portal supports the Oracle, DB2 for Windows, and SQL Server 
2000 databases. 

If your database is Oracle, perform the steps in the following section. If your 
database is DB2 or SQL Server, perform the steps in the section Create a DSN 
name on client machines for SQL Server database on page 30.

Create a TNS name for Oracle database server
You need to create a TNS name for the Oracle database server. To do so, 
perform these steps:

Verify that you select the SQL 
Server and Windows option.
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1 Open the Oracle Net Configuration Assistant.

2 Choose Local Net Service Name Configuration.

3 Create a TNS name BI_REPO.

Create a DSN name on client machines for SQL Server database
On each server machine where a database client resides, you need to create a 
DSN name in the ODBC Data Sources Administrator for DB2 and SQL 
Server databases. To do so, perform these steps:

1 Click Start > Settings > Control Panel. Double-click Administrative Tools.

2 Double-click Data Sources.

3 Add the DSN name BI_REPO in the System DSN tab. Choose the ODBC 
driver that is appropriate for your database, either DB2 or SQL Server.

4 Click Finish.

5 Type bi-repo in the Name field.

6 Select the SQL Server name you are using. Click Next.

7 Click SQL Server Authentication and type bi-repo and password in the 
appropriate login information fields. Click Next.

8 Click the Default Database box and ensure that “bi-repo” is displayed in the 
field. Click Next.

9 Click Finish. Then click Test Data Source to test the connection.

10 Repeat step 2 through step 9 to create a DSN name “RDS” for the rds 
database. Enter the name RDS (instead of “bi-repo”) and passw0rd (instead 
of “password”).

If you are using SQL Server, you register the SQL Server client.

To register a SQL Server client

1 On the server machine where SQL Server is installed click Programs > 
Microsoft SQL Server > Enterprise Manager.

2 Right-click the SQL Server group and click New SQL Server Registration to 
start the registration wizard. Click Next.

3 Select the SQL Server host name from the list and click Add. Click Next.

4 Choose the second option and click Next.

5 Enter a name and password for a user who can log onto SQL Server and click 
Next.
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6 Choose the default option, Add the SQL Server to an existing SQL Server 
group. Click Next.

7 Click Finish and then click Close.

Create a database alias on client machines for DB2 databases
The next step in configuring DB2 to function with BI Portal is to create an 
alias for the DB2 databases.

To create a DB2 alias:

1 Open the DB2 Client Configuration Assistant.

2 Click the Add button to add a database alias.

3 Find the BI_REPO database.

4 Enter the database alias bi_repo.

5 Click “Register this database for ODBC” box.

6 Click Finish.

7 Click the Test button to check the connection to the database.

8 Repeat step 2 through step 7 for the RDS database.

Create a Windows user named BO_User

On each server machine on which a BI Portal component will be installed, 
create a local user account, BO_User, who has rights to: Log on as a service 
and Act as part of the operating system. Make sure to write down the User 
name (BO_User) and password (passw0rd) for later use, in the section 
Configuring Business Objects for BI Portal on page 40.

Note: After you create BO_User on each server machine, log in to each server 
machine as BO_User before installing Business Intelligence.

To set up a user BO_User:

1 On the Desktop right-click My Computer and click Manage on the menu.

2 Open the System Tools folder and click Local Users and Groups.

3 Right-click the Users folder and click New User on the menu.

4 Type BO_User in the User name field.

5 Type passw0rd in the Password and Confirm password fields. (The sixth 
character in passw0rd is the number zero.)
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6 Make sure to un-check the box User must change password at next login.

7 Check the box Password never expires.

8 Click Create.

9 Click Groups. Double-click the Administrators group. 

10 Add BO_User to the list of administrators.

11 Click Close.

12 Close the Computer Management Console.

To assign rights to BO_User:

1 Click Start > Programs > Administrative Tools > Local Security Policy.

2 Click Local Policies.

3 Click User Rights Assignment.

4 In the Local Security Settings window double-click Act as part of the 
operating system.

5 In the Local security policy setting window click Add.

6 In the Select Users or Groups window choose BO_User from the list of users 
and click Add. Click OK twice.

7 In the Local Security Settings window double-click Log on as a service.

8 In the Local Security Policy Setting window click Add.

9 Click BO_User in the list of users and click Add. Click OK twice.

10 Close the Local Security Policies window.

11 Repeat all the steps in the section Create a Windows user named BO_User on 
each server machine where any BI Portal component is installed.

12 After you have completed all the steps, re-boot the system for your changes 
to take effect.
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Install Business Objects and configure it for BI Portal

Before you can install BI Portal, you install Business Objects and configure it. 

To install Business Objects:

1 Insert the Business Objects CD into the CDROM drive on the server machine 
where you want to install Business Objects. 

2 The Business Objects installer starts.

3 Click I accept the terms in the license agreement. and click Next.
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4 Read the installation notes and click Next.

5 Specify the folder where your Business Objects license files reside and click 
Next.

Note: When you purchase BI Portal, you purchase a license to use Business 
Objects as well. Peregrine Systems send you an e-mail file that contains 
your Business Objects license keys. You can store this file store 
wherever you like (but make sure to note its location!). When 
prompted by the following screen, you specify the location of this 
license file.
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6 Click the Check License button. Verify that your licenses appear in the Valid 
Licenses column, click OK, and click Next.

7 Enter your user name and company name and click Next.
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8 Specify that the English language Business Objects be installed and click 
Next.

9 Choose the Custom installation option. Click Next.
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10 In the Custom Setup screen, navigate to Administration Products. Click 
Auditor and select This feature will not be available.

Note: The Custom Setup screen may not appear exactly as shown because 
the Business Objects license you buy may offer different components.

11 In the Custom Setup screen navigate to Demonstrations. Select This feature 
will not be available.
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12 In the Custom Setup screen navigate to Desktop Products. Select This 
feature will not be available. Click Next.

13 In the Configure Folders screen accept the default values and click Next.
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14 In the Ready to Install the Program screen click Install.

15 When prompted to install Disk 2, insert it in the CDROM drive and click OK.

16 When the installation is complete, make sure that Configure server products 
is selected, and click Finish.
Install Business Objects and configure it for BI Portal  39



BI Portal
17 The installer asks whether you want to re-start your server machine now. 
Click No. (You will re-start your server machine later, after you configure 
Business Objects for BI Portal.)

Configuring Business Objects for BI Portal
After you install Business Objects, you configure it to function with BI Portal. 
Make sure that you are logged on as user BO_User. (You created BO_User in 
the section Create a Windows user named BO_User on page 31.)

To configure Business Objects:

Note: If you stop the configuration at any time, you need to delete the cluster 
and start from step 1.

1 In Windows click Start > Programs > Business Objects > Configuration 
tool.

2 Choose Custom.

3 Create a cluster with any name you choose. Click Next.

4 Set up ORB:

a For your first configuration select ORB, choose DEFINE ORB from the 
drop-down, and click Next. Proceed to step 5.

b If you have configured ORB previously, select ORB, choose Update ORB 
from the drop-down, and click Next.

5 You should not need to modify settings. Simply click Test Ports and verify 
that ports are available. If not, make modifications as needed. Click Next.

6 After the ORB is configured, perform the following steps in the service 
configuration screen that is displayed:

a Select Define node as a service and Start automatically. 

b Type user information that you used to create BO_USER, where the 
Domain is the name of the computer. Refer to the section Create a 
Windows user named BO_User on page 31.
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c Click Next. A message is displayed that indicates the service parameters 
have been configured successfully. 

d Click Finish.

7 Re-start your server machine so that your settings will take effect.

Install Connect-It 

Before you install BI Portal. Follow these steps:

1 Insert the Connect-It CD into the CD ROM on the same server machine 
where you intend to install RDS. If the Connect-It installer does not start 
automatically, click Start > Run and enter the following:
<CDROM drive>:\setup.exe. 

2 The Connect-It installer informs you that it is best to close all open 
applications while installing Connect-It. You can close applications from the 
Windows Task Bar. After you close all applications, click Continue.
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3 Choose the Full installation option in the Connect-It setup screen and click 
Next.

4 The Connect-It installer confirms the Program group (where you will click 
on the Windows Start menu to open Connect-It), and the folder where 
Connect-It will be installed. Click Install.
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5 The Connect-It setup screen displays the progress of the installation process.

6 If there is an existing log file, the installer asks you whether you want to 
replace it with a new version. Click Yes. (Click No only if you would lose 
important data if the log file were replaced.)
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7 The following screen indicates that Connect-It was installed successfully. 
Click OK.

8 Peregrine Customer Support provides a text file that contains an 
authorization code for the Connect-It database connector when you 
purchase BI Portal. Copy the file into a directory such as C:\Program 
Files\Peregrine\Connect-It, and note its location. When you install the RDS 
component of BI Portal, you specify the location of this file.

9 Click Exit to close the Connect-It installer.

Check ServiceCenter installation

Before you install BI Portal in any configuration, make sure that 
ServiceCenter is installed; and note the ServiceCenter server’s host name or 
IP address, and its port number. After you install RDS, you will be prompted 
to run the Connect-It Service Console and configure the RDS scenario.

Note: For information about running the RDS Service Console, see Chapter 
6, Configuring Software Components.

To check whether ServiceCenter is installed:

1 On the Windows desktop of the ServiceCenter server click My Computer. 

2 Click the root drive (usually drive C)

3 Navigate to Program Files > Peregrine. 

If Service Center is installed, a subdirectory such as ServiceCenter2 is 
included in the list of files and folders.
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3 I
nstalling on Windows
When you install BI Portal and choose the default application server, 
Tomcat, and default Web server, Apache, and you install all BI Portal 
components in C:\Program Files, you perform a typical installation. See the 
sections Performing a typical, single-machine installation on page 49 and 
Installation on multiple machines on page 89.

Whenever you use a different application server or Web server, or install any 
BI Portal components in a folder other than C:\Program Files, you perform a 
custom installation. For more information about performing a custom 
installation, see Custom installation of BI Portal on page 93.

Note: There are two versions of the BI Portal client: Windows and UNIX. 
This chapter discusses the steps you take to install the Windows 
version of the BI Portal client. To install the UNIX version of the BI 
Portal client, perform all the steps in this chapter up to the section 
Installing the Web-based interface of BI Portal on page 89 and then go 
to Chapter 4, Installing on UNIX.
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Installation configurations

This chapter includes instructions for performing a typical BI Portal 
installation in one of the following configurations:

All components on one server machine

Components on two server machines

Components on three server machines

Topics include:

Typical versus Custom installation on page 46

BI Portal configuration scenarios on page 47.

Performing a typical, single-machine installation on page 49

Configuring the portal on page 81

Installation on multiple machines on page 89

Custom installation of BI Portal on page 93

Testing your installation on page 101

Important: Before you install BI Portal, make sure to prepare for the 
installation process by performing the steps described in the 
section Software installation and configuration requirements on 
page 18.

Typical versus Custom installation

A typical BI Portal installation uses the Apache Web server and the Tomcat 
application server. Further, in a typical installation all BI Portal components 
are installed in the C:\Program Files directories of one or more server 
machines. 

If you wish to use another Web server, another application server, or install 
in a different folder, perform a custom installation. See the section Custom 
installation of BI Portal on page 93.
46 Chapter 3—Installing on Windows 



Installation Guide
BI Portal configuration scenarios

You can install all the BI Portal components on one server machine; or you 
can install BI Portal components on two, or three server machines. The 
following diagrams depict the various configuration scenarios.

One-server configuration
In this configuration, all BI Portal components are installed on one server 
machine, in addition to Connect-It and Business Objects:
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Two-server configuration (recommended)
In this configuration, the Reporting Server, BI Publisher, and the Reporting 
Data Store (RDS) are installed on one server machine; and the Web-based BI 
Portal client is installed on a second server machine:

Note: The Reporting Server must be installed on the same server machine on 
which Business Objects is installed. Further, Connect-It must be 
installed on the same server machine on which RDS is installed.

Three-server configuration
In this configuration, the Reporting Server, and BI Publisher are installed on 
one server machine; the RDS is installed on a second server machine; and the 
BI Portal Web-based client is installed on a third server machine:
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Note: The Reporting Server must be installed on the same server machine on 
which Business Objects is installed. Further, Connect-It must be 
installed on the same server machine on which RDS is installed.

Performing a typical, single-machine installation

To perform a typical installation where all BI Portal components are installed 
on one server machine, in C:\Program Files, follow these steps:

1 To start the BI Portal installation process insert the BI Portal CD into your 
CDROM drive. If the setup program fails to start, click Start > Run > and 
enter <CDROM_Drive>:\setup. 

The following screen indicates that the installation procedure has begun:
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2 Click all three check boxes, BI Portal, BI Report Server, and RDS. This 
specifies that all BI Portal components be installed on this server machine 
during this installation process.

Note: When you install BI Portal on multiple server machines, you run the 
installer separately on each server machine and select only those 
components you want to install on that server machine. See the 
section Installation on multiple machines on page 89.

3 Choose a destination location where you want BI Portal to be installed. The 
default directory location is C:\Program Files\Peregrine. Click Next.
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Note: If you prefer to install any BI Portal components in another folder, you 
perform a custom installation. See the section Custom installation of BI 
Portal on page 93.

4 If the installer cannot locate the Java SDK version 1.3 or greater, or 
WebSphere version 4.0, on your server machine, the following message box 
asks you to confirm that you want the JDK installed. Click Yes.

5 The installer locates the directory where Business Objects is installed, and 
prompts you to confirm that the location is correct. Click Next.

Note: If for some reason you changed the directory, click Browse and locate 
the directory in which Business Objects is installed. Then click Next.
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6 The installer determines the host name and cluster name of your Business 
Objects server. Click Next.

7 The installer prompts you to confirm that you want to create a Business 
Objects Repository. Choose the default, Yes, and click Next. 

Note: Click No only if you have previously created a Business Objects 
Repository. In that case, you will enter information about your 
existing Business Objects Repository in the next step.
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8 In the Repository Information screen you enter the name of the Business 
Objects Repository, the name of your company, and the name of the 
Repository group. (The Business Objects Repository is an RDBMS that 
contains the Business Objects Security, Document, and Universe domains; 
and stores all data sets and documents.) 

Accept the default values and click Next.

Note: The Company must be in uppercase letters.

9 Specify the type of database you will use for the Business Objects Repository, 
either Oracle (default), DB2, or SQL Server. Click Next.
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10 Specify the database name BI_REPO, the host name, and the port number. 
Click Next.

Note: This screen may not be displayed or may vary depending on the type 
of database you are using.

11 Specify a name for the Business Objects Repository. Accept the default value, 
BI_REPO, and click Next.
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12 The installer locates the JDBC driver that will be used with the Business 
Objects Repository, based on the database type you chose. If for some reason 
you need to specify another driver, click Browse, locate the driver, and click 
OK. Click Next.

13 The installer informs you that you must have created three database users in 
order to use BI Portal, names BI_REPO, BIREPO1, and BIREPO1L. Each 
user must have permission to create and drop tables and views, and to 
connect. Click Next.
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Note: You add these users to your database separately from this installer, 
before you begin the installation process. For more information see the 
section Software installation and configuration requirements on 
page 18. 

14 Confirm that the name of the Business Intelligence database name, database 
host name, and the URL to the JDBC driver are correct. Click Next.

15 Specify the type of database you will use for the Reporting Data Store (RDS). 
Click either Oracle (default), DB2, or SQL Server 2000, and then click Next.
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16 Verify the RDS user name, password, and database name. Click Next.

17 Accept the default name of the connection to the RDS and click Next.

Note: Do not change the name of the connection to the RDS.
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18 The installer displays all the information that it has gathered for the 
installation. Click Next.

19 The Setup Status screen displays the progress of the BI Portal installation 
process.

The installer edits configuration files; validates connections; initializes and 
configures the database; starts the WebIntelligence Cluster service; and 
configures Business Objects server connections. 
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20 If you are installing BI Portal with DB2 or SQL Server, the installer displays 
the following screen. 

Note: If you are installing BI Portal with Oracle, this screen is not displayed; 
go directly to step 21 on page 62.

Before you click OK in the BI Portal installer, perform these steps to 
configure an ODBC database driver in Business Objects:

a In Windows, click Start > Programs > Business Objects > Supervisor 6.0. 

b Log in to the Business Objects Supervisor. Type Peregrine_Supervisor in 
the User field and enter pass (lower-case) as the password. Business 
Objects displays the following screen, where you click Tools > 
Connections.
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c In the following screen click Add.

d In the following screen click ODBC Drivers (if you are using SQL Server) 
or IBM DB2 Client (if you are using DB2) and click OK.
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e In the following screen specify the following information, exactly as 
shown:

In the Name field type rds.

In the Database engine pull-down choose MS SQL Server 2000 (if you 
are using SQL Server) or DB2 Engine (if you are using DB2).

In the User name field type rds_dba (the user you already created on 
your SQL Server machine for the RDS database).

In the Password field type passw0rd (where the sixth character is the 
number zero, not the letter “O”).

In the Data source name pull-down choose rds.

f Click the Test button to ensure that the database connection has been 
successfully established.

g Click OK.

h Click OK in the following screen:
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i Exit from the Business Objects Supervisor and continue with the BI Portal 
installer in the next step.

21 If the installer encountered any errors it displays them now. You can view all 
the errors in the log file at C:\Program Files\Peregrine\bi\logs\biconfig.log. 
Correct any problems that might have occurred; click the Back button so that 
the installer can verify the corrected information; and then click Next to 
continue.

At this point the installer stops the WebIntelligence Cluster service, 
configures connections to servers and launches that portion of the BI Portal 
installer that installs the user interface.
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22 When prompted, choose the Typical install type and click Next.

Note: If you are installing on any drive other than the default drive (normally 
drive C:\Program Files\Peregrine), choose the Custom install. Choose 
the Typical install only if installing in C:\Program Files\Peregrine.

23 Choose the type of database that BI Portal will use, either Oracle (default), 
DB2, or SQL Server. Then click Next.
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24 Verify the database user name, password, and database name. (This is the 
same information you confirmed in step 16.) Then click Next.

25 The installer prompts you to verify the name of the connection to the RDS 
database. (This is the same RDS connection name you confirmed in step 17.) 
Click Next.

26 Note: Perform this step only when installing BI Portal on multiple machines.
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Specify the host name and the port number of the server machine where the 
RDS database is installed. Click Next.

27 Verify the name of the database driver and the URL that points to it. Click 
Next.
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28 Verify the path to the database driver. (This is the same information you 
confirmed in step 12.) Click Next.

29 The installer displays all the information that it has gathered for the 
installation of the OAA packages that BI Portal uses. Verify that the 
information is correct. Click Next.
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30 The Setup Status screen displays the progress of the installation process.

The BI Portal installer deploys packages.

31 The BI Portal installer displays the output of the deployment of OAA 
packages. Click Next.

The BI Portal installer installs the Tomcat application server and configures 
server connections. 
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32 The BI Portal installer displays the status of the installation process.

33 The following screen indicates that the OAA part of BI Portal was installed 
successfully. Click Finish.
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34 The following screen indicates that the installation of BI Portal was launched 
successfully. Click OK.

35 Choose the type of database that BI Portal uses, either Oracle (default), DB2, 
or SQL Server. Click Next.
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36 The installer locates the JDBC driver. (This is the same information you 
confirmed in step 12 and step 28.) Click Next.

37 Confirm the RDS database user name, password, and database name. (This 
is the same information you confirmed in step 24.) Click Next.
70 Chapter 3—Installing on Windows 



Installation Guide
38 Confirm the RDS database driver and the URL that points to it. Click Next.

The installer configures connections to the server and initializes the RDS. 

39 The installer notifies you that the BI Portal installation was successful. Make 
sure that Configure RDS Connect-It scenario is checked and click Finish.
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40 The Connect-It Service Console helps you to configure a connection between 
BI Portal and the RDS. Click New.

41 Type RDS_CIT in the Service field. Click the Browse button  and navigate 
to the following file: C:\Program Files\Peregrine\RDS\CIT\rds_sc.scn.
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42 Click the rds_sc.scn scenario file to select it, and click Open.

43 Click RDS_CIT to select it, and click Create.
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44 Click RDS_CIT to select it, and click Configure.

45 The Connect-It splash screen indicates that Connect-It is being loaded.
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46 You now begin the process of configuring scenarios and connectors. Accept 
the default name, ServiceCenter, and click Next. 

Note: Whenever one of the three ServiceCenter connectors is displayed 
throughout the scenario configuration, accept the default name and 
click Next.
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47 The connection wizard displays the server name and login of the 
ServiceCenter connection. Enter the ServiceCenter host name and port, in 
the format hostName.Port, and click Finish.

Note: Whenever you select a connection, always click the Test button to 
check the connection. Then click Close in the Test the Connection 
window.
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48 Accept the default name for the connector to the RDS, called RDS, and click 
Next.

Note: Whenever one of the five RDS connectors is displayed throughout the 
scenario configuration, accept the default name and click Next.
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49 Choose your RDS database type. In this case you selected Oracle for RDS, so 
accept the default database Connection type, Oracle (native). Click Next. 

Note: If you selected Oracle as your database, choose Oracle (Native) from 
the pull-down. If you selected DB2 as your database, choose DB2 
(Native) from the pull-down. If you selected SQL Server as your 
database, choose ODBC from the pull-down.
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50 The connection wizard displays the RDS database name, login, and 
password. Verify the values and click Finish.

51 Whenever the installer displays connector settings not related to 
ServiceCenter or RDS, accept the defaults and click Next.

52 Click RDS_CIT in the Service column and click Start.
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53 Close the Connect-It Service Console.
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Configuring the portal

You configure the portal by setting parameters in the Administration 
module.

1 To start BI Portal, choose Start > Programs > Peregrine Portal > Admin.

2 Enter System in the User Name field and click Login. 

3 In the Administration page click Settings.

4 Click the ServiceCenter tab and type settings for the ServiceCenter host, port, 
and Admin user. Click Save.

5 In the Administration page click Settings and click the Portal DB tab. Type 
sc in the Alias for field and click Save.

6 In the Administration page click Settings and click the Web Application tab. 
Type sc in the Alias for field. Click Save.
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7 In the Administration page click Settings. Click the BI tab and choose the 
database management system, database driver class, database URL, and 
Company (in capital letters). Click Save.

Example database drivers and URLs:

Database type Driver/URL

Oracle jdbc.driver=oracle.jdbc.driver.OracleDriver

jdbc.url=jdbc:oracle:oci8:@databaseName

DB2 jdbc.driver=COM.ibm.db2.jdbc.app.DB2Driver

jdbc.url=jdbc:db2:rds

SQL Server 
Sprinta driver

jdbc.driver=com.inet.tds.TdsDriver

jdbc.url=jdbc:inetdae7:hostname:port?database=
databaseName
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8 Click Reset Server. 

9 To begin using BI Portal, perform the following steps:

a Close BI Portal.

b Re-start BI Portal. In Windows click Start > Programs > Peregrine Portal 
> Login.

c Log in to BI Portal as the user name you specified.

SQL Server 
Microsoft 
driver

jdbc.driver=com.microsoft.jdbc.sqlserver.
SQLServerDriver

jdbc.url=jdbc:microsoft:sqlserver://hostName:port;
databasename=databaseName

Database type Driver/URL
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Enable the BI Portal Broadcast Agent 
To enable the BI Portal Broadcast Agent, perform the following steps on the 
server machine where the user interface component of BI Portal is installed. 
You use the BI Portal Broadcast Agent to schedule reports to run 
automatically. See the BI Portal User’s Guide for more information about 
scheduling automatic report generation.

Note: The BI Portal Broadcast Agent is available only if you chose this option 
when you purchased BI Portal.

1 Open the Business Objects Administration Console by clicking Start > 
Programs > Business Objects > Administration Console. 

2 Log in as user Peregrine_Supervisor and password pass (lower-case). The 
red X after Broadcast Agent Manager indicates that this feature is disabled.
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3 Click Broadcast Agent Manager to select it.

4 Click Add. The following window is displayed.
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5 Click Refresh BCA List.

6 In the Login field type Peregrine_Supervisor. In the Password field type pass. 
(Both entries are case-sensitive.) Click OK.
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7 Select the Broadcast Agent you want to monitor and click OK.

8 Enter the Broadcast Agent’s password, pass. Click OK.
Configuring the portal  87



BI Portal
9 The green check after Broadcast Agent Manager indicates that the Broadcast 
Agent is now enabled.
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Installation on multiple machines

You can install the Web-based user interface portion of BI Portal on a 
separate server machine, and you can install the RDS on a separate server 
machine. For diagrams that depict the various BI Portal installation 
scenarios, see the section BI Portal configuration scenarios on page 47.

Order in which BI Portal components are installed
You always install BI Portal in this order:

1 Reporting Server/BI Publisher

2 RDS database

3 BI Portal (the user interface component)

Important: Make sure to install all the BI Portal components that you intend 
to install on each server machine at one time. After you run the 
BI Portal installer on any server machine, you must uninstall BI 
Portal before you run the installer on that server machine again. 
For this reason, plan your BI Portal configuration carefully 
before you begin the process of installing BI Portal.

Installing the Web-based interface of BI Portal
Follow these steps when installing on a separate server machine.

To install the Web-based interface of BI Portal:

1 Insert the BI Portal CD into the CDROM drive on the server machine where 
you want to install the Web interface of the BI Portal. If the setup program 
fails to start, click Start > Run > and enter <CDROM_Drive>:\setup. 

2 Make sure you are logged onto the server machine on which you intend to 
install BI Portal as BO_User.
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3 Click only BI Portal and click Next.

4 Specify the name of the Reporting Server host and click Next.

5 Continue with a Typical installation, following the same steps as step 22 on 
page 63 through step 34 on page 69.
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Installing the RDS component of BI Portal
To install the RDS portion of BI Portal on a separate server machine:

1 Insert the BI Portal CD into the CDROM drive on the server machine where 
you want to install the Web interface of the BI Portal. If the setup program 
fails to start, click Start > Run > and enter <CDROM_Drive>:\setup. 

2 Click only RDS and click Next.

3 Choose the destination directory where you want the RDS installed and click 
Next.
Installation on multiple machines  91



BI Portal
4 The installer informs you that the JDK has not been installed and asks you 
whether you want to install it. Click Yes.

5 Verify that the information is correct and click Next to begin the installation 
of RDS.
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6 The installer informs you of the progress of the installation and deployment.

7 Continue with a Typical installation, following the same steps as step 35 on 
page 69 through step 53 on page 80.

Custom installation of BI Portal

This section discusses how you perform a custom installation of BI Portal.

When do I perform a custom installation?
You perform a custom installation when:

You want to install one or more BI Portal components in a directory other 
than C:\Program Files; or 

You want to use a Web server/application server combination other than 
Apache/Tomcat.

The steps you take to perform a custom installation are the same as those for 
a typical installation in step 22 on page 63, in the section Performing a typical, 
single-machine installation, except that you choose Custom rather than 
Typical.
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Sequence of steps in a custom installation 
1 Install the Web server and application server (only if you are using a Web 

server/application server combination other than the default 
Apache/Tomcat).

2 Run the BI Portal installer and choose the Custom option.

3 Configure the application server and Web server to run with BI Portal.

Configure Tomcat 4.1.24 to connect to IIS 5.0
You can use the BI Portal installer to install the Tomcat application server. If 
you use the typical installation option, the BI Portal installer configures 
Tomcat for the Apache Web server. In order to configure the Tomcat for the 
IIS Web server, you must perform a custom installation and configure IIS 
using the following instructions.

Note: These instructions are for setting up Tomcat to use a single Java 
Virtual Machine (JVM). See the Installation Guide chapter on Load 
Balancing for installing multiple JVMs.

To configure Tomcat to connect to an IIS 5.0 Web server:

Step 1 Configure the ISAPI Plug-in for IIS. See Configuring the ISAPI Plugin for IIS 
on page 95.

Step 2 Configure IIS to use isapi_redirector2.dll as an ISAPI Filter. See Configuring 
the isapi_redirector2.dll as an ISAPI filter on page 95.

Step 3 Create and configure a jakarta virtual directory in IIS. See Configuring a 
jakarta virtual directory in IIS on page 96.

Step 4 Create and configure an oaa virtual directory in IIS. See Configuring an oaa 
virtual directory in IIS on page 97.

Step 5 Edit the server.xml file to add performance settings and configure alternate 
communications ports (Optional). See Editing the server.xml file for IIS on 
page 99.

Step 6 Install Tomcat as a service using installservice.bat (Optional). This file can 
be found in the Tomcat\bin directory. See Installing Tomcat as a service on 
page 100.
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Running the installer
Run the BI Portal installer and select the Custom installation option. 

Configuring the ISAPI Plugin for IIS
The ISAPI plugin for IIS establishes a connection between Tomcat and the 
IIS Web server. Before configuring IIS to use this connector, you must 
update the registry file entry for the connector to ensure that it has the proper 
paths listed for the Tomcat application server.

The BI Portal installer automatically places a copy of the ISAPI plug-in for IIS 
in the following folder:

c:\Program Files\Peregrine\Common\Tomcat4\bin

Use the following procedures to configure the plugin for your intranet 
environment.

To configure the ISAPI plugin for IIS:

1 Open the file jk2.reg in a text editor. The default file path is:

C:\Program Files\Peregrine\Common\Tomcat4\conf

2 Verify that the “serverRoot“ and “workersFile“ values list the proper installation 
path to Tomcat. By default, these values are:

“ServerRoot”=”C:\\Program Files\\Peregrine\\Common\\Tomcat4”
“workersFile”=”C:\\Program Files\\Peregrine\\Common\\Tomcat4\\conf\\
workers2.properties”

Tip: You do not need to make any changes if you installed this file to the 
default location. 

3 Save and close the jk2.reg file.

4 Double-click on the jk2.reg file from Windows Explorer.

Windows adds the registry settings to the Windows registry.

Configuring the isapi_redirector2.dll as an ISAPI filter
To establish a connection between Tomcat and IIS, you will need to install 
isapi_redirector2.dll as an ISAPI filter. 
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To install isapi_redirect2.dll as an ISAPI filter:

1 From Windows Control Panel > Administrative Tools, open the Internet 
Services management console.

2 Right-click the Default Web Site node and then click Properties.

3 Click the ISAPI Filters tab.

4 Click Add.

5 Enter the following information:

a Filter Name: jakarta. The filter name must match the name you defined the 
jk2.reg registry file. By default, the filter name is jakarta.

b Executable: isapi_redirector2.dll. The default file path is:

C:\Program Files\Peregrine\Common\Tomcat4\bin\isapi_redirector2.dll

6 Click OK.

Note: You must stop and then start the IIS service for changes to take effect. 
You must also restart Peregrine Tomcat.

7 From the Internet Services management console, right-click the Default Web 
Site node, then select Properties>Isapi Filters again.

The ISAPI filter in IIS displays a green status arrow to indicate that it is 
running.

8 Close the Internet Services management console.

Configuring a jakarta virtual directory in IIS
The ISAPI plugin for IIS requires a specific virtual directory in order to run. 
Use the following guidelines to create the virtual directory on the Default 
Web Site. For specific instructions about configuring IIS, refer to your 
Windows Help.
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To configure a jakarta virtual directory in IIS:

1 Use the following guidelines to create the virtual directory on the Default 
Web Site.

2 For <Tomcat>, enter the path to your Tomcat installation. The default file 
path is:

3 C:\Program Files\Peregrine\Common\Tomcat4

Configuring an oaa virtual directory in IIS
To run BI Portal from IIS, you need to create a virtual directory that maps to 
your Tomcat deployment folder. For specific instructions about configuring 
IIS, refer to your Windows Help.

To configure an oaa virtual directory in IIS:

Use the following guidelines to create the virtual directory.

For <oaa>, enter the name of the virtual directory you want to use for BI 
Portal. The recommended virtual directory name is oaa. If you choose to use 
another virtual directory name, you must enter the new name in the 
following places:

Requirements for a jakarta virtual directory

Requirement Setting

Create virtual directory jakarta

Map to physical path <Tomcat>\bin

Directory access rights Read, Run scripts, Execute

Requirements for an oaa virtual directory

Requirement Setting

Create virtual directory <oaa>

Map to physical path <Tomcat>\webapps\<oaa>

Directory access rights Read, Run scripts
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Rename the folder <Tomcat>\webapps\oaa to 
<Tomcat>\webapps\<new name>

Rename the [uri] mappings in workers2.properties from oaa to the new 
virtual directory name.

Rename all the oaa context entries in mod_jk2.conf from oaa to the new 
virtual directory name.

Rename the <Context> path and docBase attributes in server.xml from oaa 
to the new virtual directory name.

Important: The virtual directory name you choose will become part of the 
URL users enter to connect to BI Portal. For example: 
http://server_name/<new name>/login.jsp

For <Tomcat>, enter the path to your Tomcat installation. The default file 
path is:

C:\Program Files\Peregrine\Common\Tomcat4

Note: Depending on your Web server configuration, if you browse to 
http://servername/oaa, the Web server may display a list of all the 
OAA files instead of the login page.

If your server displays this behavior, follow these steps to configure 
your Web server to display the OAA login page instead of a directory 
listing.

To configure IIS:

1 Open the Internet Services Manager.

2 Expand the Default Web Site.

3 Right-click on the OAA virtual directory and click Properties.

4 Click the Documents tab.

5 Verify that Enable Default Document is checked.

6 Click the Add button.

a Type login.htm. 

b Click OK.

7 Highlight login.htm and using the up and down arrows, move login.htm to 
the top of the file list.

8 Click OK to accept the changes to the OAA directory properties.
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Editing the server.xml file for IIS
A default Tomcat installation is sufficient for most BI Portal installations. 
However, if you are experiencing performance problems or communications 
port conflicts, you may need to edit the Tomcat server.xml file to correct 
these problems.

Performance settings

The Tomcat server.xml file allows you to determine how Tomcat processes 
BI Portal files. If you are experiencing performance problems, you can 
change the <Context> setting for BI Portal to disable page reloading.

Tip: Make a back up copy of the server.xml file before editing.

To edit the server.xml performance settings:

1 Open the file server.xml in any text editor. The default file path is:

C:\Program Files\Peregrine\Common\Tomcat4\conf

2 Create a <Context> element entry from Tomcat to the BI Portal deployment 
directory to establish a point of reference for docBase.

Add the entry just above the “examples” Context entry.

Example:

<Context path="/oaa"
docBase="<Tomcat>/webapps/oaa"
crossContext="false"
debug="0"
reloadable="false" >
</Context>

Setting the reloadable attribute to false results in faster JSP page processing.

For the docBase attribute, set <Tomcat> to the absolute path of the first or 
master Tomcat instance.

Communications port settings

If your BI Portal server already uses communications ports 8005 and 8009, 
you will have a port conflict if you install Tomcat with the default settings. To 
avoid a port conflict, you must edit the server.xml file to change the 
communications ports used by Tomcat.

Important: You do not need to perform these optional steps if Tomcat’s 
default communication ports are available on your server.
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Tip: Make a back up copy of the server.xml file before editing.

To edit the server.xml communications port settings:

1 Open the file server.xml in any text editor. The default file path is:

C:\Program Files\Peregrine\Common\Tomcat4\conf

2 Update the port number attribute of the <Server> element to a free 
communications port.

Note: By default, Tomcat uses port 8005 for shutdown requests.

Example:

<Server port="8005" shutdown="SHUTDOWN" debug="0">

3 Update the port attribute of the Coyote Connector <Connector> element to a 
free communications port.

Note: By default, Tomcat uses port 8009 for the Coyote connector.

Example:

<Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8009" 
minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" 
acceptCount="10" debug="0" connectionTimeout="20000" 
useURIValidationHack="false" 
protocolHandlerClassName=”org.apache.jk.server.JkCoyoteHandler” />

4 Save the server.xml file.

5 Restart Tomcat for your new settings to take effect.

Installing Tomcat as a service
After you have edited the Tomcat files, you can install Tomcat as Windows 
services using installservice.bat.

Note: The installer does not reset the JAVA_HOME environment variable 
when installing on systems where a previous instance of Tomcat is 
installed. Manually redefine the JAVA_HOME environment variable to 
point to the new Java Development Kit. The default path is: 
C:\Program Files\Peregrine\Common\jdk1.3.1_05

To install Tomcat as a service:

1 Open a DOS command prompt and change directories to your Tomcat bin 
directory.

2 Enter the following command to create each Tomcat instance:
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installservice <service name> <tomcat_home> <jvm_dll_path>

Where <service name> is the name you wish to give the Tomcat service, 
<tomcat_home> is the Tomcat install directory of the instance for which you 
are creating the service, and <jvm_dll_path> is the Java SDK install directory.

The second and third parameters are optional if you have already set the 
CATALINA_HOME and JAVA_HOME environment variables.

Example:

installservice Tomcat8009 C:\Program Files\Peregrine\Common\Tomcat4 
C:\Program Files\Peregrine\Common\jdk1.3.1_05

3 Repeat step 1 through step 2 for each Tomcat service you wish to create.

Testing your installation

Use the following steps to confirm that you have properly installed BI Portal 
on Windows.

To test your BI Portal installation:

1 Verify that your application and Web servers are started.

2 Open a Web browser and type the following in the Address field:

http://<server name>:<port>/oaa/admin.jsp

For <server name>, enter the server name where the BI Portal Web server 
resides.

For <port>, enter one of the following communications port numbers:

If everything is configured properly, the Administrator login page opens.

If the BI Portal administration login page does not open, see Troubleshooting 
for more information.

Application Server used Port Number

WebSphere 9080

Tomcat 80, can be omitted from URL
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Uninstalling BI Portal

The following instructions describe how you uninstall BI Portal from a 
single-machine implementation. These procedures remove BI Portal and all 
its components; they do not remove Business Objects from the server 
machine on which it is installed.

To uninstall BI Portal from a multiple-machine implementation, you run the 
Windows Add/Remove Programs utility as described below, on each separate 
server machine, to uninstall the BI Portal component that is installed on that 
machine.

Uninstalling BI Portal from a single server machine
Follow these procedures to uninstall BI Portal from your Windows system. 
This is a two-step process. You must first uninstall BI Portal, then delete the 
tables and documents.

Warning: These procedures remove all the components that you selected to 
install. If you chose the Typical installation option, uninstall 
removes BI Portal, Peregrine Tomcat, Apache, and JDK. If you 
chose the Custom installation option, then only those components 
that you selected to install are removed.

If the JDK was installed before you installed BI Portal, only 
portions of the JDK are uninstalled during this process. If you want 
to use JDK in the future, you need to re-install it. If not, you will 
need to run the JDK uninstaller to remove the remaining portions.

To uninstall BI Portal:

1 Access the Windows Add/Remove Programs utility on the server machine 
where the Web-based user interface component of BI Portal is installed.

2 Select Peregrine Portal 4.1 and click Change/Remove.

A status message indicates that the setup program is preparing the 
InstallShield wizard to guide you through the process.

3 The Close Programs screen opens if any BI Portal services or applications are 
running. Click Next to continue.
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4 The verification message box opens. Click Yes to continue.

Status messages indicate the termination of the services for Apache and 
Tomcat.

5 The Confirm Uninstall dialog box opens. Click OK to remove BI Portal.

Important: Back up any data you want to save before continuing.

6 The Shared Files screen opens if there are any shared files to be removed 
during setup.

If WebSphere is installed on this computer, setup will prompt you to confirm 
the removal of six JAR files. Click No or No to All to retain these JAR files.

Warning: Do not remove the shared JAR files as the WebSphere Advanced 
Administrative Console requires these files to function.

If there are no shared files to remove, then a status message indicates that the 
uninstall program is removing files from your computer.
Uninstalling BI Portal  103



BI Portal
7 The Maintenance Complete screen opens. Click Finish to complete the 
uninstall of BI Portal.

To delete the tables and documents:

1 From your database server, delete the tables in bi_repo and rds.

2 From your reporting server, delete all the documents from the 
Peregrine_Designer directory. 

The default path is: 
C:\Program Files\Business Objects\BusinessObjects Enterprise 6\nodes\bo-srv3
\bo_srv3_mycluster\storage\user\Peregrine_Designer 

3 Remove all directories from the reporting server. 

The default path is: C:\Program Files\Peregrine\bi 

4 Remove all directories from the RDS server. 

The default path is: C:\Program Files\Peregrine\rds 
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nstalling on UNIX
This chapter covers the following topics:

Choosing an installation environment on page 106

Configuring alternate application servers on page 109

Typical Installation Option on page 125

Custom Installation Option on page 135

Uninstall—AIX or Solaris on page 146

Testing your installation on page 146
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Choosing an installation environment

You can install BI Portal in one of two installation environments:

Development environment

Production environment

The BI Portal development environment is intended for you to evaluate 
product features and customize your installation prior to deployment in a 
production environment. In a development environment, you install all 
software required for BI Portal on one computer system.

You have two choices of development environment:

Typical installation

Apache 2.0 Web server

BI Portal deployed on Tomcat 4.1.24 application server

Custom installation

IBM HTTP Web server

WebSphere 4.0.2

The BI Portal production environment is intended to maximize server 
performance and scalability, and to deploy any customizations you have 
made. In a production environment, you install the various components of 
BI Portal on different servers to maximize performance.

You have two choices of production environment:

Typical installation

Apache 2.0 Web server

BI Portal deployed on multiple instances of Tomcat 4.1.24 application 
server

Custom installation

Choice of Web server

Choice of application server where you deploy BI Portal
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Development Environment
The following procedures describe how to install BI Portal in a development 
environment.

To install BI Portal in a typical development environment:

Step 1 Acquire all necessary hardware and software.

Step 2 Install the back-end database required for BI Portal.

Step 3 Install and configure database client on each server machine.

Step 4 Install the RDS, BI Reporting Server/Publisher required for BI Portal.

Step 5 Run the BI Portal installer and select the Typical installation option. See 
Typical Installation Option on page 125.

To install BI Portal in a custom development environment:

Step 1 Acquire all necessary hardware and software.

Step 2 Install the back-end database required for BI Portal.

Step 3 Install and configure database client on each server machine.

Step 4 Install the RDS, BI Reporting Server/Publisher required for BI Portal.

Step 5 Install alternate application and Web servers.

Step 6 Configure the alternate application server for BI Portal. See Configuring 
alternate application servers on page 109.

Step 7 Run the BI Portal installer and select the Custom installation option. See 
Custom Installation Option on page 135.
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Production Environment
The following procedures describe how to install BI Portal in a production 
environment.

To install BI Portal in a typical production environment:

Step 1 Acquire all necessary hardware and software.

Step 2 Install the back-end database required for BI Portal on a separate server.

Step 3 Install the database client on each server machine.

Step 4 Install the RDS, BI Reporting Server/Publisher required for BI Portal.

Step 5 Run the BI Portal installer and select the Typical installation option. See 
Typical Installation Option on page 125.

Step 6 Configure multiple instances of Tomcat for load balancing on the Apache 
Web server. See the Load Balancing chapter of this guide.

To install BI Portal in a custom production environment:

Step 1 Acquire all necessary hardware and software.

Step 2 Install the back-end database required for BI Portal.

Step 3 Install the database client on each server machine.

Step 4 Install the RDS, BI Reporting Server/Publisher required for BI Portal.

Step 5 Install the alternate application server and Web server on separate servers.

Step 6 Configure the alternate application server for BI Portal. See Configuring 
alternate application servers on page 109.

Step 7 Run the BI Portal installer and select the Custom installation option. See 
Custom Installation Option on page 135.

Step 8 Configure the Web servers and application servers for load balancing. See the 
Load Balancing chapter of this guide.

If your database is SQL Server, there is no database client to install on the 
UNIX machine where BI Portal component is installed. If your database is 
Oracle or DB2, you must install the database client on all the client machines 
including the UNIX machine where BI Portal component is installed.
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On the UNIX machine where only the BI Portal component is being 
installed:

If your database is Oracle, you must create a TNS name for the Oracle 
database server. 

If your database is DB2, you must create an alias for the BI_REPO and 
RDS databases and register them. 

See Install the database client on each server machine in Chapter 2 of this guide, 
or contact your DBA.

Configuring alternate application servers

You must install a Java-enabled application server to support your Peregrine 
Web applications. Peregrine OAA supports the following alternate 
application servers:

Existing Tomcat and Apache servers

WebSphere Application Server 4.0.2

The BI Portal typical installation option installs Tomcat 4.1.24 and connects 
it to an Apache 2.0 web server. You can also install Tomcat 4.1.24 using the 
custom installation option.

Important: If you want to use an application server other than Tomcat 
4.1.24, then you must configure your application and Web 
servers prior to running the BI Portal installer.

See the following sections for instructions configuring alternate application 
servers for BI Portal.
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Existing Tomcat and Apache servers
If you use the typical installation option, the BI Portal installer configures 
Tomcat to connect to a new instance of the Apache Web server. If you have 
existing instances of Tomcat or Apache Web Server installed, you can 
configure BI Portal to use these existing instances by copying the necessary 
files from a typical installation.

To configure an existing Tomcat server to connect to an Apache server:

1 Copy the following files from the installation CD \SupportFiles… directory 
to the directories indicated below.

Note: The mod_jk.dll included with this release is compatible with 
Apache 2.0.43 and Tomcat 4.1.25. If you are using other versions, refer 
to the jakarta.apache.org/builds/jakarta-tomcat-connectors/jk/doc 
site to download the compatible version.

2 Using a text editor, open the files mod_jk.conf and workers.properties. 
These files are located in the /conf directory of your Tomcat installation.

a Find all instances where the path to Tomcat appears and edit these to 
reflect your current Tomcat 4.1 installation path. 

b Find all instances where the path to JDK appears and edit these to reflect 
your current JDK installation path.

3 Using a text editor, open the httpd.conf file. This file is located in the /conf 
directory of your Apache installation.

a Add the path to your existing Tomcat installation to the include statement 
in the Global Environment section:

### Section 1: Global Environment
...
include "<Tomcat_path>/conf/mod_jk.conf"

Copy this file To the following location

mod_jk.conf The /conf directory of your existing Tomcat installation. 
The default source file path is: 
/usr/local/peregrine/common/Tomcat 4/conf

workers.properties The /conf directory of your existing Tomcat installation. 
The default source file path is: 
/usr/local/peregrine/common/Tomcat 4/conf

mod_jk.dll The /modules directory of your existing Apache 
installation. The default source file path is:
/usr/local/peregrine/common/apache2/modules
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For <Tomcat_path>, enter the absolute path to your Tomcat installation.

b Add login.jsp to the list of files in the DirectoryIndex section:

# DirectoryIndex: Name of the file or files to use as a pre-written
# HTML directory index.  Separate multiple entries with spaces.
#
<IfModule mod_dir.c>

   DirectoryIndex index.html login.jsp
</IfModule>

c Add the following line to the end of the file:

Alias <Tomcat>/webapps/oaa
where <Tomcat> is the path to your Tomcat installation.

4 Install BI Portal using the Custom option. See Custom Installation Option on 
page 135. 

5 Restart Tomcat and Apache.

6 Browse to the BI Portal login URL and verify that you can successfully 
connect.

Note: Depending on your Web server configuration, if you browse to 
http://servername/oaa, the Web server may display a list of all the 
OAA files instead of the login page.

If your server displays this behavior, follow these steps to configure 
your Web server to display the OAA login page instead of a directory 
listing.

To configure Apache to display login.jsp by default:

1 Open Apache’s conf/httpd.conf file in a text editor.

2 Find the existing line that reads DirectoryIndex index.html.

3 Add login.jsp to the end:

DirectoryIndex index.html login.jsp

4 Save httpd.conf.

5 Restart the Apache Web server.

WebSphere Application Server 4.0.2
Use the following procedures to configure WebSphere to run BI Portal on 
AIX.
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To configure WebSphere Application Server 4.02:

Step 1 Install WebSphere 4.02. Your version of WebSphere 4.0.2 includes the IBM 
HTTP Server. Installing WebSphere 4.02 on page 112.

Step 2 Deploy the Portal WAR file to WebSphere to create the necessary folder 
structure for BI Portal. See Deploying the Portal WAR file to WebSphere on 
page 113.

Step 3 Run the BI Portal installer. See Running the BI Portal installer on page 115.

Step 4 Configure the JVM settings to your database classes. See Configuring the JVM 
settings on page 116.

Step 5 Set the JVM Java heap size for each WebSphere instance running BI Portal. 
See Setting the Java heap size on page 117.

Step 6 Create the local.xml file. See Creating the local.xml file on page 118.

Step 7 Configure the portal to connect to the report server. See Configuring the 
portal to connect to the report server on page 119.

Step 8 Copy the jar files. See Copying jar files on page 120.

Step 9 Create the virtual directory you want to use for BI Portal in your Web server. 
See Configuring a virtual directory for IBM HTTP Server on page 120.

Step 10 Regenerate and configure. See Regenerating the plug-in configuration on 
page 121.

Step 11 Modify the etc/hosts file. See Modifying the etc/hosts file on page 122.

Step 12 Start BI Portal. See Starting Business Intelligence Application on page 122.

Step 13 Optionally, add another wijsp Web application. See Adding a wijsp Web 
application on page 123.

Installing WebSphere 4.02
Purchase and install IBM WebSphere 4.0.2. Your version of WebSphere 4.0.2 
includes the IBM HTTP Server.

Verify that you install fix pack 3. To check this, go to the 
default_server_Stdout.log file under /Websphere/AppServer/logs.
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Deploying the Portal WAR file to WebSphere
The Portal WAR file creates the folder structure necessary to deploy BI Portal 
in your application server. 

To deploy the Portal WAR file to WebSphere:

1 Verify that the WebSphere Admin Server has been started.

2 Open the WebSphere Advanced Administrator’s Console 
(/WebSphere/AppServer/bin/adminclient.sh).

3 On the menu at the left side of the console, right-click on Enterprise 
Applications and select Install Enterprise Application.

4 Update the web.xml file in portal.war to create the Enterprise Application in 
WebSphere.

a Type the command:
Cd /usr/BI/peregrine/oaa/packages

b Using the jar command, extract WEB-INF/web.xml from the 
BI<version>.zip file, where version is version of BI Portal.

For example, $JAVA_HOME/bin/jar -xvf BI.5.0.11.zip WEB-INF/web.xml

c Using the jar command, update the WEB-INF/web.xml file in 
portal<version>.war file, where version is the version number of the WAR 
file you installed.

For example, $JAVA_HOME/bin/jar -uvf portal<version>.war WEB-INF/web.xml 

5 On the screen displayed, do the following:

a Select Install stand-alone module.

b In the Path field, browse to the path to the portal<version #>.war file. The 
default is /usr/BI/peregrine/oaa/packages.

For <version #>, select the most recent version available (4.0.0.44 or 
greater).

c In the Application Name field, type oaa.

d In the Context Root field, type the name of BI Portal virtual Web server 
directory you wish to use. Example: /oaa.

Important: You must create a Web server virtual directory matching the 
context root you enter here.
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The following screen shows the completed form.

6 Click Next.

7 Click Next on the following dialog boxes. These screens will not be used.

Mapping Users to Roles

Mapping EJB Run As Roles to Users

Binding Enterprise Beans to JNDI Names

Mapping EJB References to Enterprise Beans

Mapping Resource References to Resources

Specifying the Default Datasource

Specifying Data Sources for Individual CMP Beans
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8 In the Selecting Virtual Hosts for Web Modules, select the WebSphere server 
instance you want to use, and then click Next.

9 In the Selecting Application Servers dialog box, select the WebSphere server 
instance you want to use, and then click Next.

10 On the dialog box displayed, click Finish.

Running the BI Portal installer
Run the BI Portal installer and select the Custom installation option. See 
Custom Installation Option on page 135.
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If you choose /usr/BI as the installation location, the contents of this 
directory include:

/usr/BI/peregrine/bi

/usr/BI/peregrine/oaa/external/

/usr/BI/peregrine/oaa/packages

Configuring the JVM settings
BI Portal requires that you configure the JVM settings to your database 
classes.

To configure the JVM settings:

1 Verify that the WebSphere Admin Server has been started.

2 Open the WebSphere Advanced Administrator’s Console 
(/WebSphere/AppServer/bin/adminclient.sh).

3 Click Nodes > <System Name> > Application Servers > <Application server 
name>.

The server settings page opens.
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eton
4 Click the JVM Settings tab.

5 Under Classpaths, click Add to add the path to your application classes 
directory.

/usr/WebSphere/AppServer/InstalledApps/oaa.ear/portal.<version>.war
/WEB-INF/classes

6 Click Add again.

If you are using Oracle, provide the path to the classes12.jar file:

$ORACLE_HOME/jdbc/lib/classes12.jar

If you are using DB2, provide the path to db2java.zip file: 
<DB2_installationdir>/java/db2java.zip.

7 Under System Properties, click Add.

a In the Name field, type java.library.path.

b In the Value field, type 
/usr/WebSphere/AppServer/InstalledApps/oaa.ear/<version>.war/WEB-INF/lib
/AIX/ServiceCenter4 

where version is the version number of your WAR file.

8 Click Advanced JVM Settings.

a Add the following to the command line argument field:

b Add the following to the boot classpath prepend field:
/usr/BI/peregrine/bi/bo/wiapi/lib/bo_orb.jar 

c Click OK, then click Apply.

Setting the Java heap size
You can configure how much memory is available for your application server 
instances. The following instructions assume you are only using one 
WebSphere instance. You will need to adjust the heap size accordingly if you 
are load balancing across several WebSphere instances.

To set the Java heap size:

1 Verify that the WebSphere Admin Server has started.

2 Open the WebSphere Advanced Administrator’s Console (Start > Programs 
> IBM WebSphere > Application Server > Administrator’s Console).

-Dorg.omg.CORBA.ORBClass=com.iona.corba.art.artimpl.ORBImpl
-Dorg.omg.CORBA.ORBSingletonClass=com.iona.corba.art.artimpl.ORBSingl
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3 Click Nodes > <System Name> > Application Servers > <Application server 
name>.

The server settings page opens.

4 Click the JVM Settings tab.

5 Set the following JVM settings:

a Initial java heap size. Type 60. 

b Maximum java heap size. Type the value you want for heap memory. This 
setting should be at least 225 MB, but not more than 512 MB.

Note: Make sure that the setting for maximum heap size is less than the free 
RAM available to the application server(s). Exceeding the amount of 
available RAM causes the JVM processes to swap to disk, reducing 
overall performance. A setting of 256 MB should be sufficient for most 
systems.

Creating the local.xml file

After you deploy BI Portal, you must create a local.xml file.
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kg>
To create the local.xml file:

Copy the following six lines from the <settings> section of 
<appserver>/WEB-INF/default\archway.xml to the <settings> section in 
your <appserver>/WEB-INF/local.xml file, where <appserver> is the location 
of your application server:

Configuring the portal to connect to the report server

After creating the local.xml, you must configure the portal to connect to the 
report server.

To configure the portal to connect to the report server:

1 Type the following commands:

where version is the version number of your WAR file and clustername is the 
name used when you configured the Business Objects server.

2 Using a text editor, create a webi.properties file in the classes directory in the 
path /usr/WebSphere/AppServer/InstalledApps/oaa.ear/portal.<version>.war
/WEB-INF/classes (where version is the version number of your WAR file) with 
the following contents:

Note: Make sure that the TEMP_DIR entry in the file exists and that the user 
has write permissions to that TEMP_DIR. Modify the ORBDOMAIN 
value with the correct clustername.

<?xml version="1.0"?>
<settings>
<SSLProvider>com.ibm.jsse.JSSEProvider</SSLProvider>
<HTTPSHandlerPkg>com.ibm.net.ssl.internal.www.protocol</HTTPSHandlerP
<CryptoProvider>com.ibm.crypto.provider.IBMJCE</CryptoProvider>

</settings>

cd /usr/WebSphere/AppServer/InstalledApps/oaa.ear
/portal.<version>.war/WEB-INF/classes
cp /usr/BI/peregrine/bi/shared/<clustername>.cfg .

#
#Mon Sep 15 10:23:31 PDT 2003
default_HsalPath=/wijsp/servlet/com.bo.hsal.HSALServlet
XML_TRANSFORMER=org.apache.xalan.processor.TransformerFactoryImpl
TEMP_DIR=/usr/BI/peregrine/bi/tmp
ORBDomain=mycluster
BalanceAlgorithm=None
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Copying jar files

The following instructions describe where to find and copy the .jar files.

You must also copy the database driver file to the WEB-INF/lib directory.

For the SqlServer Database using the Microsoft JDBC driver, copy the 
following files:

Msutil.jar 

MsSqlServer.jar 

Msbase.jar 

Note: You can download these files from the Microsoft Web site.

For SqlServer Database using Sprinta2000.jar, copy Sprinta2000.jar.

Configuring a virtual directory for IBM HTTP Server
You must configure a virtual directory for BI Portal in your Web server. The 
following instructions assume that you are using WebSphere’s built-in Web 
server – IBM HTTP Server. See your Web server documentation to 
determine how to create a virtual directory if you are using another Web 
server.

To configure IBM HTTP Server for BI Portal:

1 Stop the IBM HTTP Server.

2 Open the file httpd.conf in any text editor. By default this file is located at:

<root>/usr/HTTPServer/conf

3 Add the following line to the end of the file:

Alias /oaa/ "<root>/WebSphere/AppServer/installedApps/oaa.ear/portal.
<version>.war/"

For <root>, enter the root directory of the system.

cd /usr/WebSphere/AppServer/InstalledApps/oaa.ear/portal.<version>.war
/WEB-INF/lib
cp /usr/BI/peregrine/oaa/external/xalan.jar .

cp /usr/BI/peregrine/oaa/external/xercesImpl.jar .
cp /usr/BI/peregrine/oaa/external/xmlParserAPIs.jar .
rm bo_orb.jar
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For <version>, enter the version number of the WAR file you installed.

Note: The name you define for the virtual directory here must match the 
context root you defined in WebSphere.

Note: The BI Portal installer creates duplicate alias entries in the IBM HTTP 
Server when you install more than one Peregrine OAA Platform 
application on WebSphere. 

Duplicate entries can also occur if you reinstall BI Portal or install 
another Peregrine OAA Platform application on a system that 
formerly had BI Portal installed on it.

Remove any duplicate alias entries from the IBM HTTP Server 
httpd.conf file.

4 Save the file.

5 Start the IBM HTTP Server.

Regenerating the plug-in configuration
You must regenerate the plug-in configuration using the WebSphere Admin 
console after running the BI Portal installer.

To regenerate the plug-in configuration:

1 Open the WebSphere Advanced Administrator’s Console (Start > Programs 
> IBM WebSphere > Application Server > Administrator’s Console).

2 Click Nodes > <System Name> > Application Servers > <Application server 
name>.
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The server settings page opens.

3 Right-click on the <System Name>, then select Regen Webserver Plugin.

4 Restart your application server.

Modifying the etc/hosts file
Verify that your system can connect to the webintelligence server and the 
RDS database server. For example:

ping mywebintelligencehost 
ping myrdsdatabasehost 
ping schost 

If you receive an error such as unknown host, you modify the /etc/hosts file. 
You can also contact your UNIX System Administrator for help. 

Starting Business Intelligence Application
Using WebSphere Admin Console, start the oaa Web application. Restart the 
IBMHTTPServer on the server machine.

Right-click on your 
system name and 
select Regen 
Webserver Plugin.
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To modify the BI Portal Admin settings:

1 Type the following in the Address field:

http://<server name>/oaa/admin.jsp 

For <server name>, enter the server name where the BI Portal Web server 
resides.

If everything is configured properly, the Administrator login page opens.

2 Log on as System, no password.

Note: See Configuring the portal in the Installing on Windows chapter of this 
guide.

3 From the Admin Home page, click Settings.

4 Configure the BI, Common, Portal, Portal DB, and ServiceCenter tabs.

Adding a wijsp Web application
For testing purposes, you can add additional wijsp Web applications.

To add a wijsp Web application:

1 Create the wijsp.war file from wi_tosca.zip, excluding the 
WEB-INF/lib/bo_orb.jar file, by typing the following commands:

2 Using WebSphere Admin Console (see Configuring the JVM settings on 
page 116), create a new Enterprise Application using the wijsp.war created in 
the $JAVA_HOME/bin/jar -cvf wijsp.war wijsp command.

Note: Before performing the following instructions, verify that the classes 
directory exists in the path 
/usr/WebSphere/AppServer/InstalledApps/wijsp.ear/wijsp.war/WEB-INF/ 
If it does not exist, then create the directory with the following 
commands:
cd /usr/WebSphere/AppServer/InstalledApps/wijsp.ear/wijsp.war/WEB-INF
mkdir classes 

cd /usr/BI/peregrine/bi/portal/setup
mkdir wijsp
cd wijsp/
$JAVA_HOME/bin/jar -xvf ../wi_tosca.zip
cd /usr/BI/peregrine/bi/portal/setup/wijsp/WEB-INF/lib
rm bo_orb.jar
cd /usr/BI/peregrine/bi/portal/setup/wijsp
$JAVA_HOME/bin/jar -cvf wijsp.war 
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a From the JVM Settings for wijsp Enterprise Application, update 
Classpath:

/usr/WebSphere/AppServer/InstalledApps/wijsp.ear/wijsp.war/WEB-INF/classes 

b  Update the command line argument:

-Dorg.omg.CORBA.ORBClass=com.iona.corba.art.artimpl.ORBImpl 

-Dorg.omg.CORBA.ORBSingletonClass=com.iona.corba.art.artimpl.ORBSingleton 

c Update the boot classpath prepend:

usr/BI/peregrine/bi/bo/wiapi/lib/bo_orb.jar 

3 Perform the following commands:

4 Copy the resource files to wijsp web application.

5 Using WebSphere Admin Console, regenerate the plugin and start the 
Enterprise Application.

6 Restart IBMHTTPServer on the server machine.

7 Test the wisjp Web application.

a Go to the URL http://<server name>:<port>/wijsp/.

b Type the name (Peregrine_Supervisor) and password (pass) when 
prompted.

c Click Search under Corporate Documents.

d Click one of the document links.

e Click on the Edit link in the upper left corner of the page to complete the 
test.

cp /usr/WebSphere/AppServer/InstalledApps/oaa.ear/oaa.war/WEB-INF/class
/usr/WebSphere/AppServer/InstalledApps/wijsp.ear/wijsp.war/WEB-INF/clas
cd /usr/WebSphere/AppServer/InstalledApps/wijsp.ear/wijsp.war/WEB-INF/l
cp /usr/BI/peregrine/oaa/external/xalan.jar .
cp /usr/BI/peregrine/oaa/external/xercesImpl.jar .
cp /usr/BI/peregrine/oaa/external/xmlParserAPIs.jar .

cd /usr/WebSphere/AppServer/InstalledApps/wijsp.ear/wijsp.war
$JAVA_HOME/bin/jar -xvf 
/usr/BI/peregrine/bi/portal/setup/wi_tosca_websphere.zip
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Typical Installation Option

A typical installation of BI Portal installs the most commonly used 
components of the product and saves application files and data in default 
destination directories. Most users choose Typical installation.

Typical Installation Components
Following is a brief description of the components that are automatically 
installed with a Typical installation of BI Portal:

Applications and File Locations

Communications Ports
BI Portal uses the following communications ports in a typical installation. 
After installation, you can configure BI Portal to use one or more of the 
alternate communications ports if your local network already uses these 
communications ports.

BI Portal Component Default Installation Directory

Apache Web Server /usr/local/peregrine/common/apache2

Tomcat Application Server /usr/local/peregrine/common/tomcat4

Java Development Kit /usr/local/peregrine/common/jdk1.3.1

OAA Platform and BI Portal /usr/local/peregrine/oaa

Default 
Port Component used by

Alternate 
Port

80 Apache Web Server 8081

8005 Tomcat application server administration 8015

8009 Tomcat application server worker file 8019

8011 Tomcat application server worker file for load balancing 
(optional)

8021

8013 Tomcat application server worker file for load balancing 
(optional)

8023

8015 Tomcat application server worker file for load balancing 
(optional)

8025
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Note: To change settings for these components or to use or install different 
components, use the Custom installation option for BI Portal.

Typical Installation Procedures
This section explains how to install BI Portal with a Tomcat application 
server and an Apache web server on an AIX or Solaris operating system.

Note: If you cancel the installation before completing all the steps, you must 
run Uninstall to remove all the files.

To perform a typical installation of BI Portal on AIX or Solaris:

1 Log into your server with an account that has root privileges.

Important: Verify that your temp directory has a minimum of 300 MB of 
available space. On Solaris, for example, the system-wide temp 
directory is /tmp.

2 Insert the BI Portal installation CD into your computer’s CD ROM drive. 
Your computer should automatically launch the installation program.

Exit the automatic launch and mount your CD ROM drive. For example:

mount /cdrom

Change directories to your CD ROM. For example:

cd /cdrom

Enter the installer script specific for your operating system:

Operating system Shell script to run

AIX 5.1 ./setupaix

Solaris 2.6, 7, 8, 9 ./setupsolaris
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The installer welcome page opens.

3 Click Next to continue to the next page of the wizard.

The installation location page opens.

4 Click Browse to change the default installation location of /usr/local.
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5 Click Next to open the next page of the wizard that instructs you to stop your 
application server and Web server.

6 Click Next to continue to the next page of the wizard.

The setup type page opens.

7 Select Typical.

Click Typical.
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8 Click Next to open the list of components that will be installed.

Note: The list depends on the application that you install.

9 Click Next to continue installing BI Portal components.

The installation progress page opens.
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The installer verifies the availability of port 80 for the Apache Web server. If 
the installer finds a port conflict on port 80, the WebServer Port page opens.

10 If required, enter the new Web server communications port, then click Next.

11 Change the Tomcat memory settings as needed, and click Next.
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12 Click Next to open the deployment utility page that starts deploying BI Portal 
components.

13 Click Next to view the list of all deployed packages.

Note: The list of deployed packages depends on the application that you 
install.

.
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14 Click Next to continue installing BI Portal.

15 Using File Transfer Protocol (FTP), move the contents from your shared 
directory on your reportserver to the location of your BI Portal installation, 
then click Next.
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16 Type the cluster name used when you configured the Business Objects server, 
then click Next.

The installer runs the required shell scripts. 

17 Click Next.
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The start OAA page opens.

18 Click Yes to start BI Portal immediately or select No to manually start BI 
Portal after installation is complete.

If you want BI Portal to start every time the server is started, then copy the 
file oaactl into your startup directory. The default file location is: 
/usr/local/peregrine/bin/.

19 Click Finish to complete the BI Portal installation. 

If you have not already done so, you need to configure your system to 
connect to the database you are using. This is done on the Settings page of the 
Admin module.  See Configuring the portal in the Installing on Windows 
chapter of this guide for more information about the BI tab settings.

Select Yes
to start BI Portal 
immediately.
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Custom Installation Option

The following section describes how to perform a custom installation of BI 
Portal on a UNIX operating system server, including overview steps for a 
Development and Production environment.

Custom Installation Components
Following is a brief description of the components that are available for a 
custom installation of BI Portal:

Application options

Communications Ports
The communications ports used by a custom installation of BI Portal depend 
upon the application components that you select. Refer to your Web and 
application server documentation to determine what communications port 
they require. After installation, you can configure BI Portal to use alternate 
communications ports if your local network already uses particular 
communications ports.

BI Portal on servers running Oracle 9.2.0.1

If you are running BI Portal on a server using Oracle 9.2.0.1 you may 
experience a port conflict over communications ports 8009 and 8080. 
Consult your Web and application server documentation to see if they use 
either of these two ports.

If you are using Tomcat as your application server, then by default, there will 
be a port conflict over port 8009. It is recommended that you change Tomcat 
to use a different communications port on servers running Oracle 9.2.0.1.

BI Portal Component Options

Web Server Apache 2.0.43
IBM HTTP Server 1.3.19
Microsoft IIS 5.0 for Win 2000

Application Server Tomcat 4.1.24
WebSphere 4.02, 5.0

Java Development Kit Java 2 SDK
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Custom Installation Procedures
Note: If you cancel the installation before completing all the steps, you must 

run Uninstall to remove all the files.

To perform a custom installation of BI Portal on UNIX:

1 Log into your server with an account that has root privileges.

Important: Verify that your temp directory has a minimum of 300 MB of 
available space. On Solaris, for example, the system-wide temp 
directory is /tmp.

2 Insert the BI Portal installation CD into your computer’s CD ROM drive. 
Your computer should automatically launch the installation program.

If the installation program does not automatically start, mount your CD 
ROM drive. For example:

mount /cdrom

Change directories to your CD ROM. For example:

cd /cdrom

Enter the installer script specific for your operating system:

Operating system Shell script to run

AIX 5.1 ./setupaix

Solaris 2.7 ./setupsolaris

Solaris 2.8 ./setupsolaris
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The installer welcome page opens.

3 Click Next to continue.

The installation location page opens.

4 Click Browse to change the default installation location of /usr/local.
Custom Installation Option  137



BI Portal
5 Click Next to read the information about closing the servers before 
continuing with the installation.

6 Click Next to open the setup type page.

7 Select Custom.

Click Custom.
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The review components page opens.

Note: The list of features on this page depends on what you actually install.

8 Click Next to start installing BI Portal components.

The installation progress page opens.

9 Click Next to configure a WebSphere application server.
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The WebSphere AppServer installation location page opens.

a Click Browse to locate the directory where you installed the WebSphere 
AppServer. Click Next to continue.

b Click Browse to locate the directory where you deployed the portal.war 
file. Click Next to continue.

WebSphere automatically created this directory when you deployed the BI 
Portal portal.war as an enterprise application. See WebSphere Application 
Server 4.0.2 on page 111 for more information about deploying a WAR 
file.
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The WebSphere JDK installation location page opens.

c Click Browse to locate the directory where you installed the Java 
development kit used by WebSphere. Click Next to read the information 
about the screen.

\

d Click Next to continue.
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The BI Portal deployment utility page opens.

e Click Next to view the list of all deployed packages.

Note: The list of deployed packages depends on what you actually install.
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f Click Next to open the IBM HTTP Server location page.

g Click Browse to locate where you installed the IBM HTTP Server. Click 
Next to continue.

The BI Portal installer automatically configures a Web server virtual 
directory called oaa. If you want to define a different Web server virtual 
directory, see WebSphere Application Server 4.0.2 on page 111 for a list of 
requirements.

The installer screen indicates what components are being installed.

10 Click Next to continue.
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11 Using File Transfer Protocol (FTP), move the contents from your shared 
directory on your reportserver to the location of your BI Portal installation, 
then click Next.

12 Type the cluster name used when you configured the Business Objects server, 
then click Next.
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13 Click Finish to close the installer.

If you have not already done so, you need to configure your system to 
connect to the database you are using. This is done on the Settings page of the 
Admin module. See Configuring the portal in the Installing on Windows 
chapter of this guide for more information about the BI tab settings.

Configuring the WebSphere startupServer.sh on AIX
If you are running on an AIX server, you must configure your WebSphere 
environment by editing the startupServer.sh script.

To configure the WebSphere environment on AIX:

1 Open startupServer.sh in any text editor.

2 Add an entry for LIBPATH and set it to the path values for AIX.

Example:

#!/bin/sh
LIBPATH=/usr/lib:/WebSphere/AppServer/installedApps/oaa.ear/portal.4.
0.0.55.war/WEB-INF/lib/AIX:/WebSphere/AppServer/installedApps/answer.
ear/portal.4.0.0.55.war/WEB-INF/lib/AIX/ServiceCenter4
export LIBPATH

3 Save the file.
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Uninstall—AIX or Solaris

Use the following instructions to uninstall BI Portal. This is a two-step 
process. You must first uninstall BI Portal, then delete the tables and 
documents. See the Uninstall section of the Installing on Windows chapter in 
this guide for information about deleting the tables and documents.

Warning: These procedures remove all the components that you selected to 
install. If you chose the Typical installation option, uninstall 
removes BI Portal, Peregrine Tomcat, Apache, and JDK. If you 
chose the Custom installation option, then only those components 
that you selected to install are removed.

To uninstall BI Portal from AIX or Solaris:

1 Connect to your AIX or Solaris system.

2 Change directories to:

<root>peregrine/_uninst

where <root> is the path to your BI Portal installation.

3 Enter the following command to uninstall BI Portal:

./uninstall.bin

Note: You must stop the servers before proceeding. From the 
<root>/peregrine/bin directory, type the command: ./ooactl stop.

4 Follow the on-screen instructions to complete the uninstall.

Testing your installation

Use the following steps to confirm that you have properly installed BI Portal 
on AIX or Solaris.

To test your BI Portal installation:

1 Verify that your application and Web servers are started.

2 Open a Web browser and type the following in the Address field:

http://<server name>:<port>/oaa/admin.jsp

For <server name>, enter the server name where the BI Portal Web server 
resides.
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For <port>, enter one of the following communications port numbers:

If everything is configured properly, the Administrator login page opens.

If the BI Portal administration login page does not open, see Troubleshooting 
for more information.

Application Server used Port Number

WebSphere 80, can be omitted from URL

Tomcat 80, can be omitted from URL
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This chapter covers the following topics:

Load balancing application servers on page 150

Creating multiple instances of Tomcat for Apache on page 152

Creating multiple instances of Tomcat for IIS on page 163
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Load balancing application servers

A server running a Web application such as Peregrine’s Get-Services or 
Get-Resources consumes approximately 256 MB of memory per application 
server instance. You should not set the maximum heap size of the JVM in 
excess of the free RAM available to the application server(s). Exceeding the 
amount of available RAM causes the JVM processes to swap to disk, reducing 
overall performance.

Unlike other Adapters, the AssetCenter and ServiceCenter Adapters each 
create a single connection to the respective back end. Therefore, the memory 
consumed on the AssetCenter database server is the same as that consumed 
by a single client connection. The memory consumed on the ServiceCenter 
server is also the same as that of a single ServiceCenter client process. 

Note that memory usage does not increase significantly per session, because 
the architecture is based on the sharing of a set of resources and database 
connections among all sessions handled by the same application server 
instance. The small amount of memory consumed for session-specific 
information is released as the users log off or as their sessions expire. Note 
that server sessions do not expire unless the browser is closed or the user 
navigates to a different domain.

Because ServiceCenter and AssetCenter adapters maintain a single 
connection to the back end, adding extra application server instances brings 
the added benefit of concurrent access to the back-end data store.

The need for extra application server instances and therefore JVMs is directly 
related to three variables:

The number of concurrent users.

The processing power of the machine hosting the BI Portal Web server.

The number of processors on the machine. 

Each deployment may make different demands of the software and 
hardware, but, in any case, optimal back-end throughput for ServiceCenter 
and AssetCenter is achieved with the maximum number of application server 
instances that the server can handle without degraded performance due to 
lack of CPU headroom, file system swapping, and context switching. 

Cache synchronization with Symmetric MultiProcessing (SMP) servers can, 
in most cases, be ignored as a performance tuning factor except in the case of 
the extremely large-scale systems.
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To serve as a control guideline, low-end processors, such as a Pentium 450, 
should be capable of producing acceptable load handling for around 100 
concurrent sessions on a single application server process. A dual Pentium 
1000 with 2 gigabytes of RAM (a common data center configuration) should 
be capable of handling 400+ concurrent sessions using multiple application 
server instances. When using adapters capable of pooling, for example, the 
JDBCAdapter or BizDocAdapter, performance beyond the 
400-concurrent-user benchmark can be achieved.

The following diagram illustrates the architecture of multiple JVMs:

Note: A white paper on Peregrine OAA architecture and optimization is 
available on the Customer Support Web site at 
http://support.peregrine.com. 
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Creating multiple instances of Tomcat for Apache

You can create multiple instance of Tomcat to load balance requests to BI 
Portal. You can configure each instance of Tomcat as a service. Although this 
is not required, it improves performance, makes the instances easier to 
manage, and provides extra functionality, including restarting the service if 
it fails or if the machine on which the instances are installed needs to be 
restarted.

Note: The following procedures assume that you have already installed BI 
Portal. Refer to either the Windows or UNIX installation chapter for 
more information on installing BI Portal.

For systems using IIS, see Creating multiple instances of Tomcat for IIS on 
page 163.

To create multiple Tomcat instance for Apache:

Step 1 Log in to the BI Portal admininstration page and disable the script pollers 
setting. See Disabling script pollers on the primary Tomcat instance on 
page 153.

Step 2 Create copies of the Tomcat directory, then delete the \webapps\oaa 
directory from the newly copied instances of Tomcat. See Copying the Tomcat 
directory on page 153.

Step 3 Edit the workers.properties file of the first or primary Tomcat instance to set 
the values for each additional Tomcat instance. See Editing the 
workers.properties file on page 154.

Step 4 Edit the mod_jk.conf file of the first or primary Tomcat instance to establish 
a connection between Tomcat and Apache. See Editing the mod_jk.conf file on 
page 156.

Step 5 Edit the httpd.conf file to define the Tomcat workers available for Apache. 
See Editing the httpd.conf file on page 157.

Step 6 Edit the server.xml files for each Tomcat instance. See Editing the server.xml 
files for Apache on page 157.

Step 7 Edit the jk2.properties files for each Tomcat instance. See Editing the 
jk2.properties files for Apache on page 159.
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Step 8 Install multiple instances of Tomcat as a service using installservice.bat. This 
file can be found in the Tomcat\bin directory. See Installing Tomcat instances 
as services for Apache on page 160.

Step 9 Log in to the BI Portal admininstration page for the primary Tomcat instance 
and enable the script pollers setting. See Enabling script pollers on the primary 
Tomcat instance on page 161.

Step 10 Testing the configuration. See Testing load balancing on Apache on page 161.

Disabling script pollers on the primary Tomcat instance
You only need one Tomcat instance running script pollers. Before you copy 
your primary Tomcat instance, you should login to the BI Portal 
administration page and turn off script polling. This will disable script 
polling on all of the Tomcat instances you create by copying the primary 
Tomcat instance.

To disable script pollers on the primary Tomcat instance:

1 Log in to the BI Portal administration page. The default URL is:

http://<server_name>/oaa/admin.jsp

2 Click Settings.

BI Portal displays the common settings page.

3 Scroll down to the Server-Side Scripts section, and select No for the Enable 
scipt pollers option.

4 Scroll down to the bottom of the form and click Save.

BI Portal displays the Control Panel page.

5 Click Reset Server to commit your changes.

6 Log out of the BI Portal administration page.

7 Stop the Peregrine Tomcat service to temporarily disable BI Portal.

Copying the Tomcat directory
You must create a separate folder for each instance of Tomcat you want to 
use for load balancing.
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To copy the Tomcat directory:

1 Open Windows Explorer and copy the Tomcat install folder. The default file 
path is:

C:\Program Files\Peregrine\Common\Tomcat4

2 Paste a copy into the same root path. The default file path is:

C:\Program Files\Peregrine\Common

3 Rename the new folder to a unique name.

Tip: Include the port number to be used by the Tomcat instance in the folder 
name. For example, if you are going to use 4 instances of Tomcat 
listening on ports 8009, 8011, 8013, and 8015, then you can create 3 
copies of the Tomcat folder called \Tomcat4_8011, \Tomcat4_8013, 
and \Tomcat4_8015. The primary instance uses port 8009.

Warning: If you are using more than four Tomcat instances, change the port 
numbers to avoid conflicts.

4 Delete the \webapps\oaa subdirectory from the newly copied instance of 
Tomcat.

The additional instances will use the same document root as the first or 
primary Tomcat instance.

5 Repeat step 1 through step 4 for each instance of Tomcat you want to use.

Editing the workers.properties file
For each server on which Tomcat instances are installed, there is only one 
workers.properties file. Tomcat installs the workers.properties file in the 
conf directory of your primary Tomcat instance. This file will be shared by all 
other Tomcat instances on that particular server.

The workers.properties file specifies the worker threads that the Web server 
connector will create in order to communicate with the Tomcat instances. 
Each Tomcat instance must communicate on a different port. The host 
should be set to the name of the server running the Tomcat instances or 
localhost if they are running on the same server as Apache.

Cache size is the maximum number of user sessions that Apache should 
direct to the Tomcat instance at one time. 
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Lbfactor is a number greater than or equal to 1 that Apache uses to load 
balance the workers. If all the workers are running on servers that have equal 
performance strengths, the lbfactor numbers should be equal. Workers with 
a lower lbfactor will be assigned fewer user sessions by the load balancer 
worker in Apache.

To edit the workers.properties file:

1 Open the workers.properties file in any text editor.

This file is located in the conf directory of your Tomcat installation.

2 Edit the following lines as shown. The paths for workers.tomcat_home and 
workers.java.home are the locations of your Tomcat installation and Java 
SDK installations.

Example:

workers.tomcat_home="c:\Program Files\Peregrine\common\Tomcat4"
workers.java.home="c:\Program Files\Peregrine\common\jdk1.3.1_05"
ps=\
worker.list=loadbalancer, ajp13, w8011, w8013, w8015

Find the worker.loadbalancer.type=lb code and make changes to the line that 
follows as shown below.

worker.loadbalancer.type=lb
worker.loadbalancer.balanced_workers=ajp13, w8011, w8013, w8015

Note: You can define the worker names any way you want as long as you 
continue the same naming convention throughout the procedure.

3 Add the following lines for each Tomcat instance you have installed, 
incrementing the port number for the values shown in step 2:

worker.w8011.port=8011
worker.w8011.host=localhost
worker.w8011.type=ajp13
worker.w8011.cachesize=40
worker.w8011.lbfactor=10

Note: All Tomcat instances share this workers.properties file; therefore, all 
additional lines must be in the file for the primary Tomcat instance.

4 Update the last two lines in the Default ajp13 Worker Definition section.
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The first three lines are already in the file.

5 Save the file.

Editing the mod_jk.conf file
The mod_jk.conf file defines where the Worker files are available in Apache. 
This file is shared by all Tomcat instances on the server. It is important that 
you do this procedure after you have successfully deployed the necessary BI 
Portal files, otherwise the BI Portal mount points, file locations, and 
directories will not be included in the mod_jk.conf file, and you will have to 
manually add them.

To edit the mod_jk.conf file:

1 Make a copy of the mod_jk.conf file and rename the copy to 
mod_jk.conf-local.

The mod_jk.conf file is located in the Tomcat conf directory.

Note: This is done only on the primary Tomcat instance.

2 Open the mod_jk.conf-local file in any text editor.

3 Change JKWorkersFile to point to the worker.properties file of the primary 
Tomcat instance.

Example:

JkWorkersFile "C:\Program Files\Peregrine\Common\Tomcat4
\conf\worker.properties"

4 Change all JkMounts to use loadbalancer instead of default worker ajp13.

Usage: JkMount<file(s) or directory> <worker name>

Example:

JkMount/oaa/servlet/* loadbalancer
JkMount/oaa/*.jsp loadbalancer

worker.ajp13.port=8009
worker.ajp13.host=localhost
worker.ajp13.type=ajp13
.
.
.
worker.ajp13.lbfactor=10
worker.ajp13.cachesize=40

Change lbfactor from =1 to =10
Change cachesize from =10 to =40

Find the worker.ajp13.lbfactor=10 code 
and make changes as shown below
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5 Save the file.

Editing the httpd.conf file
The httpd.conf file must include mod_jk.conf-local.

To edit the httpd.conf file:

1 Open the httpd.conf file in any text editor.

The default location is: 
C:\Program Files\Peregrine\Common\Apache2\conf.

2 Update the following line to include -local:
include "<Tomcat>/conf/mod_jk.conf-local"

For <Tomcat>, enter the path to your Tomcat installation. The default file 
path is: C:\Program Files\Peregrine\Common\Tomcat4

3 Save the file.

Editing the server.xml files for Apache
You will need to modify the server.xml file for each Tomcat instance. The 
server.xml file contains the information Tomcat needs to connect to the Web 
server as well as to find the Peregrine OAA Platform Web application files.

Tip: Make a back up copy of the server.xml file before editing.

To edit the server.xml files:

1 Each Tomcat instance has a server.xml file located in the conf directory. 
Open this file in any text editor.

2 Verify that the port number attribute of the <Server> element is a unique 
value that does not conflict with other port numbers used by Tomcat. It is 
recommended that the port numbers 8005-8008 be used for the shutdown 
port when configuring four Tomcat instances.

Example:

<Server port="8005" shutdown="SHUTDOWN" debug="0">

Note: This is not the worker communications port number. The worker port 
number is defined in step 4 on page 158.
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Warning: If you are using more than four Tomcat instances, change the port 
numbers to avoid conflicts.

3 Comment out a <Connector> tag with the 
className="org.apache.coyote.tomcat4.CoyoteConnector" using port 8080.

Tomcat uses this port to communicate with a browser for direct HTTP 
requests. Since Apache will be serving the static data, Tomcat does not need 
to listen on this connector. It will also prevent a user from directly accessing 
Tomcat instances.

Example:

4 Update the port number used by the Coyote Connector to a unique, 
non-conflicting value. If you are configuring four Tomcat instances, the 
values 8009 (as the primary port), 8011, 8013, and 8015 are recommended.

Example:

5 Update the <Engine> element with the server name and communications port 
used by each Tomcat instance.

Example:

<!-- Define a non-SSL Coyote HTTP/1.1 Connector on port 8080 -->
<!--
<Connector className="org.apache.coyote.tomcat4.CoyoteConnector" 
port="8080" minProcessors="5" maxProcessors="75" 
enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" 
connectionTimeout="20000" useURIValidationHack="false" />
-->

<!-- Define a Coyote/JK2 AJP 1.3 Connector on port 8009 -->
<Connector className="org.apache.coyote.tomcat4.CoyoteConnector" 
port="8009" minProcessors="5" maxProcessors="75" 
enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" 
connectionTimeout="20000" useURIValidationHack="false" 
protocolHandlerClassName="org.apache.jk.server.JkCoyoteHandler" />

<!-- Define the top level container in our container hierarchy -->
<Engine jvmRoute="localhost:8009" name="Standalone" 
defaultHost="localhost" debug="0">
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The port number should follow the convention used elsewhere in the 
configuration (8009, 8011, and so on). These entries must be the same as the 
Tomcat ID entries you added to the workers.properties file in the primary 
Tomcat instance.

6 Update the appBase attribute of the <Host> element with the absolute path to 
the webapps directory of the primary Tomcat instance.

Example:

7 Create a <Context> element entry in the first or primary Tomcat instance and 
copy it to the other Tomcat instances, changing the OAA context so that it is 
not reloadable.

This prevents Tomcat from reloading the servlet without restarting the 
service. It improves performance and helps keep the JSP code that the 
Tomcat instances are serving in sync during an update.

Add the entry just above the “examples” Context entry.

Example:

For the docBase attribute, set <First Tomcat install> to the absolute path of the 
first or primary Tomcat instance.

8 Save the file.

9 Repeat step 2 through step 7 for each server.xml file in each Tomcat instance 
you made.

Editing the jk2.properties files for Apache
You will need to modify the jk2.properties file for each Tomcat instance. 
This file sets the jk2 communication port.

<!-- Define the default virtual host -->
<Host name="localhost" debug="0" 
appBase="C:\Program Files\Peregrine\Common\Tomcat4\webapps" 
unpackWARs="true" autoDeploy="true">

<Context path="/oaa"
docBase="<First Tomcat install>/webapps/oaa"
crossContext="false"
debug="0"
reloadable="false" >
</Context>
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To edit the jk2.properties files:

1 Open the jk2.properties file for a Tomcat instance in a text editor.

This file is located in the Tomcat conf directory.

2 Insert a line for the channelSocket port. The port number must match the port 
number defined in workers.properties file for this Tomcat instance.

Example:

channelSocket.port=8009

3 Save the file.

4 Repeat step 1 through step 3 for each Tomcat instance. 

Installing Tomcat instances as services for Apache
After you have edited the Tomcat files, you can install each instance of 
Tomcat as Windows services using installservice.bat.

To install Tomcat instances as services on Apache:

1 Open a DOS command prompt and change directories to your Tomcat bin 
directory.

2 Enter the following command to create each Tomcat instance:

installservice <service name> <tomcat_home> <jvm_dll_path>

Where <service name> is the name you assign to the Tomcat service, 
<tomcat_home> is the Tomcat install directory of the instance for which you 
are creating the service, and <jvm_dll_path> is the Java SDK install directory.

Note: The <service name> cannot have a space in it.

The second and third parameters are optional if you have already set the 
CATALINA_HOME and JAVA_HOME environment variables.

Warning: The command to create Tomcat instances cannot accept spaces in 
the file path. 

Example:

installservice Tomcat8009 C:\Progra~1\Peregrine\Common\Tomcat4_8009 
C:\Progra~!\Peregrine\Common\jdk1.3.1_05\jre\bin\server\jvm.dll

Note: Use the Windows naming convention to avoid problems of spaces in 
the file path name. For example, replace Program Files with Progra~1.
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3 Repeat step 1 through step 2 for each Tomcat service you wish to create.

Tip: You can easily remove a service. From the DOS command prompt, 
change directories to your Tomcat bin directory, then enter the 
following command: Tomcat -uninstall <service name>. The 
command is case-sensitive.

4 Start each Tomcat service that you install.

Enabling script pollers on the primary Tomcat instance
You only need one Tomcat instance running script pollers. Before you test 
your load balancing configuration, you should login to the BI Portal 
administration page of the primary Tomcat instance and turn on script 
polling.

To enable script pollers on the primary Tomcat instance:

1 Log in to the BI Portal administration page of the Tomcat instance. The 
default URL is:

http://<server_name>:<port_number>/oaa/admin.jsp

For <port_number>, enter the port number you have defined for your 
primary Tomcat instance. This is typically port 8009.

2 Click Settings.

BI Portal displays the common settings page.

3 Scroll down to the Server-Side Scripts section, and select Yes for the Enable 
script pollers option.

4 Scroll down to the bottom of the form and click Save.

BI Portal displays the Control Panel page.

5 Click Reset Server to commit your changes.

6 Log out of the BI Portal administration page.

Testing load balancing on Apache
After you have created additional Tomcat instances, you can test if load 
balancing is occurring using the following steps.

To test load balancing:

1 Start all Tomcat instance services.
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If you installed Tomcat as a service you can open the Windows Control Panel 
and start each instance from the Services dialog box.

2 Open a browser and log in to BI Portal.

3 Perform an action in BI Portal. For example, perform a search.

4 Logout of BI Portal.

5 Close your browser to clear the connection cache.

6 Repeat step 1 through step 5 one time for each Tomcat instance installed. For 
example, if you have 4 Tomcat instances, then you will need to login and 
logout a total of 4 times.

The load balancing mechanism uses a Round-Robin algorithm. If load 
balancing is working successfully, each login attempt should use a different 
Tomcat instance.

7 Download the archway.log file.

You can download the archway.log file from the Administration > Server 
Log page.

8 Open the archway.log file in a text editor.

9 Verify that connection details list a different Tomcat instance for each 
connection.

If each connection uses a different Tomcat instance, then the system is load 
balancing properly.

If each connection uses the same Tomcat instance, the system is not load 
balancing and needs troubleshooting.
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Creating multiple instances of Tomcat for IIS

Multiple instances of Tomcat are installed as services. Although this is not 
required, it improves performance, makes the instances easier to manage, 
and provides extra functionality, including restarting the service if it fails or 
if the machine on which the instances are installed needs to be restarted.

To create multiple Tomcat instance for IIS:

Step 1 Log in to the BI Portal admininstration page and disable the script pollers 
setting. See Disabling script pollers on the primary Tomcat instance on 
page 164.

Step 2 Create copies of the Tomcat directory, then delete the \webapps\oaa 
directory from the newly copied instances of Tomcat. See Copying the Tomcat 
directory on page 164.

Step 3 Configure the ISAPI Plugin for IIS. See Configuring the ISAPI Plugin for IIS 
on page 165.

Step 4 Create and configure a jakarta virtual directory in IIS. See Creating and 
configuring a jakarta virtual directory in IIS on page 166.

Step 5 Configure IIS to use isapi_redirector2.dll as an ISAPI Filter. See Configuring 
the isapi_redirector2.dll as an ISAPI filter on page 166.

Step 6 Create and configure an oaa virtual directory in IIS. See Creating and 
configuring an oaa virtual directory in IIS on page 167.

Step 7 Edit the workers2.properties file of the first or master Tomcat instance to set 
the values for each additional Tomcat instance. See Editing the 
workers2.properties file for IIS on page 168.

Step 8 Edit the server.xml files for each Tomcat instance. See Editing the server.xml 
files for IIS on page 169.

Step 9 Edit the jk2.properties files for each Tomcat instance. See Editing the 
jk2.properties files for IIS on page 171.

Step 10 Install multiple instances of Tomcat as a service using installservice.bat. This 
file is in the Tomcat\bin directory. See Installing Tomcat instances as services 
for IIS on page 171.
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Step 11 Log in to the BI Portal admininstration page for the primary Tomcat instance 
and enable the script pollers setting. See Enabling script pollers on the primary 
Tomcat instance on page 172.

Step 12 Testing the configuration. See Testing load balancing on IIS on page 173.

Disabling script pollers on the primary Tomcat instance
You only need one Tomcat instance runningscript pollers. Before you copy 
your primary Tomcat instance, you should login to the BI Portal 
administration page and turn off script polling. This will disable script 
polling on all of the Tomcat instances you create by copying the primary 
Tomcat instance.

To disable script pollers on the primary Tomcat instance:

1 Log in to the BI Portal administration page. The default URL is:

http://<server_name>/oaa/admin.jsp

2 Click Settings.

BI Portal displays the common settings page.

3 Scroll down to the Server-Side Scripts section, and select No for the Enable 
scipt pollers option.

4 Scroll down to the bottom of the form and click Save.

BI Portal displays the Control Panel page.

5 Click Reset Server to commit your changes.

6 Log out of the BI Portal administration page.

7 Stop the Peregrine Tomcat service to temporarily disable BI Portal.

Copying the Tomcat directory
You must create a separate folder for each instance of Tomcat you want to 
use for load balancing.

To copy the Tomcat directory:

1 Open Windows Explorer and copy the Tomcat install folder. The default file 
path is: C:\Program Files\Peregrine\Common\Tomcat4

2 Paste a copy into the same root path. The default file path is: 
C:\Program Files\Peregrine\Common

3 Rename the new folder to a unique name.
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Tip: Include the port number to be used by the Tomcat instance in the folder 
name. For example, if you are going to use 4 instances of Tomcat 
listening on ports 8009, 8011, 8013, and 8015, then you could create 4 
copies of the Tomcat folder called \Tomcat4_8009, \Tomcat4_8011, 
\Tomcat4_8013, and \Tomcat4_8015.

Warning: If you are using more than four Tomcat instances, change the port 
numbers to avoid conflicts.

4 Delete the \webapps\oaa subdirectory from the newly copied instance of 
Tomcat.

The additional instances will use the same document root as the first or 
primary Tomcat instance.

5 Repeat step 1 through step 4 for each instance of Tomcat you want to use.

Configuring the ISAPI Plugin for IIS
The BI Portal installer automatically places a copy of the ISAPI plugin for IIS 
in the following folder: c:\Program Files\Peregrine\Common\Tomcat4\bin

Use the following procedures to configure the plugin for your intranet 
environment.

To configure the ISAPI plugin for IIS:

1 Open the file jk2.reg in a text editor. The default file path is: 
C:\Program Files\Peregrine\Common\Tomcat4\conf

2 Verify that the “serverRoot“ and “workersFile“ values list the proper installation 
path to Tomcat. By default, these values are:

“ServerRoot”=”C:\\Program Files\\Peregrine\\Common\\Tomcat4”
“workersFile”=”C:\\Program Files\\Peregrine\\Common\\Tomcat4\\conf
\\workers2.properties”

3 Save and close the jk2.reg file.

4 Double-click on the jk2.reg file from Windows Explorer.

Windows adds the registry settings to the Windows registry.
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Creating and configuring a jakarta virtual directory in IIS
The ISAPI plugin for IIS requires a specific IIS virtual directory in order to 
run. Use the following guidelines to create the IIS virtual directory. For 
specific instructions about IIS, refer to Windows Help.

Requirements for jakarta virtual directory 

For <Tomcat>, enter the path to your Tomcat installation. The default file 
path is: C:\Program Files\Peregrine\Common\Tomcat4\bin. This path must 
contain the isapi_redirector2.dll file.

Configuring the isapi_redirector2.dll as an ISAPI filter
To establish a connection between Tomcat and IIS, you will need to install 
the file isapi_redirector2.dll as an ISAPI filter. 

To install isapi_redirect2.dll as an ISAPI filter:

1 From Windows Control Panel > Administrative Tools, open the Internet 
Services management console.

2 Right-click the Default Web Site node and then click Properties.

3 Click the ISAPI Filters tab.

4 Click Add.

5 Enter the following information:

a Filter Name: jakarta. The filter name must match the name you defined the 
jk2.reg registry file. By default, the filter name is jakarta.

b Executable: isapi_redirector2.dll. The default file path is: 
C:\Program Files\Peregrine\Common\Tomcat4\bin\isapi_redirector2.dll

6 Click OK.

7 From the Internet Services management console, right-click the Default Web 
Site node, then select Properties>Isapi Filters again.

Requirement Setting

Create virtual directory jakarta

Map to physical path <Tomcat>\bin

Directory access rights Read, Run scripts, Execute
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The ISAPI filter in IIS displays a green status arrow to indicate that it is 
running.

8 Close the Internet Services management console.

Note: You must stop and then start the IIS service for changes to take effect. 
You must also restart Tomcat.

Creating and configuring an oaa virtual directory in IIS
To run BI Portal from IIS, you need to create a virtual directory that maps to 
your Tomcat deployment folder.

Requirements for oaa virtual directory 

For <oaa>, enter the name of the virtual directory you want to use for BI 
Portal. The recommended virtual directory name is oaa. If you choose to use 
another virtual directory name, you must enter the new name in the 
following places:

Rename the folder <Tomcat>\webapps\oaa to 
<Tomcat>\webapps\<new name>

Rename the [uri] mappings in workers2.properties from oaa to the new 
virtual directory name.

Rename all the oaa context entries in mod_jk2.conf from oaa to the new 
virtual directory name.

Rename the <Context> path and docBase attributes in server.xml from oaa 
to the new virtual directory name.

Important: The virtual directory name you choose will become part of the 
URL users enter to connect to BI Portal. For example:
http://server_name/<new name>/login.jsp

Requirement Setting

Create virtual directory <oaa>

Map to physical path <Tomcat>\webapps\oaa

Directory access rights Read, Run scripts
Creating multiple instances of Tomcat for IIS  167



BI Portal
For <Tomcat>, enter the path to your Tomcat installation. The default file 
path is: C:\Program Files\Peregrine\Common\Tomcat4

Editing the workers2.properties file for IIS
For each server on which Tomcat instances are installed, there is only one 
workers2.properties file. Tomcat installs the workers.properties file in the 
conf directory of your primary Tomcat instance. This file is shared by all 
other Tomcat instances on that particular server.

The workers2.properties file specifies the worker threads that the Web server 
connector creates in order to communicate with the Tomcat instances. Each 
Tomcat instance must communicate on a different port. The host should be 
set to the name of the server running the Tomcat instances or localhost if they 
are running on the same server.

To edit the worker2.properties file:

1 Open the workers2.properties file, located in the conf directory of your 
primary Tomcat installation, in any text editor.

2 Create a channel.socket entry for each Tomcat instance (also known as a 
worker).

Example:

[channel.socket:<server>:<port>]
info=Description of Tomcat instance
debug=0
tomcatId=<server>:<port>
lb_factor=1
disabled=0

For <server>, enter the server name where the Tomcat instance is located.

For <port>, enter the communications port on which the Tomcat instance is 
listening.

The lb_factor is a number greater than or equal to 1 that IIS uses to load 
balance the workers. If all the workers are running on servers that have equal 
performance strengths, you should set the lb_factor numbers to equal values 
(typically 1). If you want to assign fewer user sessions to a given Worker, then 
assign it a lower lb_factor number relative to the other Workers.

3 Verify that the uri settings lists the proper IIS virtual directory. By default, the 
virtual directory is oaa.
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If you defined a different virtual directory other than oaa to run BI Portal, 
you will need to change the uri values here.

Example:

4 Save the file.

Editing the server.xml files for IIS
You will need a separate server.xml file for each Tomcat instance that will be 
running concurrently. This file contains the information Tomcat needs to 
connect to the Web server as well as to find the Peregrine OAA Platform Web 
application files.

Tip: Make a back up copy of the server.xml file before editing.

To edit the server.xml files:

1 Each Tomcat instance has a server.xml file located in the conf directory. 
Open it in any text editor.

2 Update the port number attribute of the <Server> element to a unique value 
that will not conflict with other port numbers used by Tomcat.

Peregrine Systems recommends that you use the port numbers 8005-8008 
when configuring four Tomcat instances.

Warning: If you are using more than four Tomcat instances, change the port 
numbers to avoid conflicts.

Example:

<Server port="8005" shutdown="SHUTDOWN" debug="0">

3 Update the port number attribute of the Coyote Connector <Connector> 
element to a unique value that will not conflict with other port numbers used 
by Tomcat.

Peregrine Systems recommends that you use port numbers 8009, 8011, 8013, 
and 8015 when configuring the Coyote Connector.

uri:/oaa/servlet/*]
info=Prefix mapping

[uri:/oaa/*.jsp]
info=Extension mapping
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Example:

4 Create a <Context> element entry from the first or primary Tomcat instance 
and copy it to the other Tomcat instances.

Add the entry just above the “examples” Context entry.

Example:

<Context path="/oaa"
docBase="<First Tomcat install>/webapps/oaa"
crossContext="false"
debug="0"
reloadable="false" >
</Context>

For the docBase attribute, set <First Tomcat install> to the absolute path of the 
first or primary Tomcat instance.

5 Update the jvmRoute attribute of the <Engine> element with the server name 
and communications port used by each Tomcat instance.

Example:

<Engine jvmRoute=”localhost:8009” name=”Standalone” 
defaultHost=”localhost” debug=”0”>

6 Update the <Host> element with the webapps directory used by the first or 
primary Tomcat instance.

List the server information in the appBase attribute.

Example:

<Host name=”localhost” debug=”0” 
appBase=”<First Tomcat install>/webapps” unpackWARs=”true” 
autoDeploy=”true”>

For the appBase attribute, set <First Tomcat install> to the absolute path of the 
first or master Tomcat instance.

7 Comment out port 8080 in the non-SSL Coyote HTTP... statement.

<Connector className="org.apache.coyote.tomcat4.CoyoteConnector" 
port="8009" minProcessors="5" maxProcessors="75" enableLookups="true" 
redirectPort="8443" acceptCount="10" debug="0" 
connectionTimeout="20000" useURIValidationHack="false" 
protocolHandlerClassName=”org.apache.jk.server.JkCoyoteHandler” />
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Example:

8 Save the file server.xml.

9 Repeat step 2 through step 8 for each copy of the server.xml file you made.

Editing the jk2.properties files for IIS
You will need to modify the jk2.properties file for each Tomcat instance. 
This file sets the jk2 communication port.

To edit the jk2.properties files:

1 Open the jk2.properties file for a Tomcat instance in a text editor.

This file is located in the Tomcat conf directory.

2 Insert a line for the channelSocket port. The port number must match the port 
number defined in workers2.properties file for this Tomcat instance.

Example:

channelSocket.port=8009

3 Save the file.

4 Repeat step 1 through step 3 for each Tomcat instance. 

Installing Tomcat instances as services for IIS
After you have edited the Tomcat files, you can install each instance of 
Tomcat as Windows services using installservice.bat.

To install Tomcat instances as services on IIS:

1 Open a DOS command prompt and change directories to the bin directory 
of your Tomcat instance.

2 Enter the following command to create each Tomcat instance:

installservice <service name> <tomcat_home> <jvm_dll_path>

<!-- Define a non-SSL Coyote HTTP/1.1 Connector on port 8080 -->
<Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
port="8080" minProcessors="5" maxProcessors="75"
acceptCount="10" debug="0" connectionTimeout="20000"
useURIValidationHack="false" />
-->
Creating multiple instances of Tomcat for IIS  171



BI Portal
Where <service name> is the name you assign to the Tomcat service, 
<tomcat_home> is the Tomcat install directory of the instance for which you 
are creating the service, and <jvm_dll_path> is the Java SDK install directory.

Note: The <service name> cannot have a space in it.

The second and third parameters are optional if you have already set the 
CATALINA_HOME and JAVA_HOME environment variables.

Warning: The command to create Tomcat instances cannot accept spaces in 
the file path.

Example:

installservice Tomcat8009 C:\Progra~1\Peregrine\Common\Tomcat4 
C:\Progra~1\Peregrine\Common\jdk1.3.1_05\jre\bin\server\jvm.dll

Note: Use the Windows naming convention to avoid problems of spaces in 
the file path name. For example, replace Program Files with Progra~1.

3 Repeat step 1 through step 2 for each Tomcat service you wish to create.

Tip: You can easily remove a service. From the DOS command prompt, 
change directories to the bin directory of your Tomcat instance, then 
enter the following command: Tomcat -Uninstall <service name>.

4 Start each Tomcat instance that you install.

Enabling script pollers on the primary Tomcat instance
You only need one Tomcat instance running script pollers. Before you test 
your load balancing configuration, you should login to the BI Portal 
administration page of the primary Tomcat instance and turn on script 
polling.

To enable script pollers on the primary Tomcat instance:

1 Log in to the BI Portal administration page of the Tomcat instance. The 
default URL is:

http://<server_name>:<port_number>/oaa/admin.jsp

For <port_number>, enter the port number you have defined for your 
primary Tomcat instance. This is typically port 8009.

2 Click Settings.
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BI Portal displays the common settings page.

3 Scroll down to the Server-Side Scripts section, and select Yes for the Enable 
scipt pollers option.

4 Scroll down to the bottom of the form and click Save.

BI Portal displays the Control Panel page.

5 Click Reset Server to commit your changes.

6 Log out of the BI Portal administration page.

Testing load balancing on IIS
After you have created additional Tomcat instances, you can test if load 
balancing is occurring using the following steps.

To test load balancing:

1 Start all Tomcat instance services.

If you installed Tomcat as a service, you can open the Windows Control 
Panel and start each instance from the Services dialog box.

2 Open a browser and log in to BI Portal.

3 Perform an action in BI Portal. For example, perform a search.

4 Logout of BI Portal.

5 Close your browser to clear the connection cache.

6 Repeat step 1 through step 5 one time for each Tomcat instance installed. For 
example, if you have 4 Tomcat instances, then you will need to login and 
logout a total of 4 times.

The load balancing mechanism uses a Round-Robin algorithm. If load 
balancing is working successfully, each login attempt should use a different 
Tomcat instance.

7 Download the archway.log file.

You can download the archway.log file from the Administration > Server 
Log page.

8 Open the archway.log file in a text editor.

9 Verify that connection details list a different Tomcat instance for each 
connection.

If each connection uses a different Tomcat instance, then the system is load 
balancing properly.
Creating multiple instances of Tomcat for IIS  173



BI Portal
If each connection uses the same Tomcat instance, the system is not load 
balancing and needs troubleshooting.
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6 C
onfiguring Software Components
After you install BI Portal, either a custom or typical install, whether on a 
single server machine or on multiple server machines, you need to configure 
additional software components so that BI Portal will function properly.

Topics in this section include:

Adding BI Portal Security Capabilities to ServiceCenter on page 176

Configuring the BI Portal Administration page on page 177
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Adding BI Portal Security Capabilities to ServiceCenter

After installing BI Portal, you need to add BI Portal security capabilities to 
ServiceCenter. Then ServiceCenter administrators can assign security roles 
to BI Portal users. Security roles control the reports that users can run and 
view.

To add BI Portal security capabilities to ServiceCenter:

1 Start the ServiceCenter client that resides on the same server machine as the 
RDS.

2 Click the Toolkit tab.

3 Click Database Manager.

4 Click the Options > Import/Load menu.

5 Click the Locate button .

6 Locate the file bi_caps.unl. The file is found in most installations at:
C:\Program Files\Peregrine\RDS\conf.

7 Click Open.

8 In the ServiceCenter File Load/Import form click the Load FG button.

To assign a BI Portal user capability to a ServiceCenter Reporting user:

1 Click the Utilities tab.

2 Click Administration.

3 In the Security area click the Operators button. 

4 Click the Startup tab.

5 In the User Capabilities drop-down, choose BIRoles:BI_Access for each user. 
This user capability is required for all users who need access to the BI Portal 
Reporting form.

6 In the User Capabilities drop-down, choose another user capability based on 
the level of access that the user should have. 

For more information about user capabilities and the level of access that they 
grant, see the Security chapter in the BI Portal Administration Guide.
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Configuring the BI Portal Administration page

After you install BI Portal, you log in to BI Portal as user name System, click 
Settings, and check the settings on the BI and Logging tabs.

Settings on the BI tab
Click the BI tab and verify that all the settings are correct. The database 
settings shown on this tab pertain to the RDS database.
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Settings on the Logging tab
Click the Logging tab and make sure that Show form info is set to No.
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A T
roubleshooting the installation
This chapter covers the following topics:

Troubleshooting Apache Web server for Windows on page 180

Troubleshooting Apache Web server for UNIX on page 183

Troubleshooting Tomcat on page 184

Troubleshooting OAA on page 187

Troubleshooting WebSphere on page 188

Troubleshooting ServiceCenter server on page 188

Troubleshooting BI Portal on page 190

BI Portal Log Files on page 195
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Troubleshooting Apache Web server for Windows

If you are having trouble with the Apache Web server for Windows, follow 
these instructions.

The Web server is not responding
If the Web server is not responding:

Step 1 Verify that the network connections are enabled.

Step 2 Verify that the apache.exe program is running.

Step 3 Restart Apache service.

Step 4 Make sure the port that Apache uses is not in use by another network service 
(Apache uses port 80 by default).

To verify that the network connections are enabled:

1 Click Start.

2 Point to Settings.

3 Click Network and Dial-up connection.

4 Click Local area connection.

5 In the dialog box, verify that under Connection, Status is listed as Connected.

To verify that the apache.exe program is running:

1 Press Ctrl+Alt+Del.

2 Click Task Manager.

3 On the Processes tab, verify that the Apache.exe program is listed in the 
Image Name column.

To restart Apache service:

1 Click Start.

2 Click Programs.

3 Click Administrative Tools.

4 Click Services.

5 Locate the Apache service in the list and restart it.
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To make sure the port that Apache uses is not in use by another network 
service (Apache uses port 80 by default):

1 Stop Apache.

a Click Start.

b Click Programs.

c Click Administrative Tools.

d Click Services.

e Locate the Apache service in the list and stop it.

2 Click Start.

3 Click Run.

4 Enter cmd and click OK.

5 In the command line window, enter netstat -a and press return.

6 Make sure that an entry with Proto=TCP, Local Address=<host>:http does 
not exist. 

Note: This ensures that when Apache is not running, no other service is 
listening on the http port (80).

7 Correct the problem by either changing Apache’s default port (refer to 
customization documentation) or disabling/changing the conflicting service.

Users cannot access the Web server even though the server is
running, and the network and Internet connections are enabled

If users cannot access the Web server, follow these instructions:

Step 1 Verify that the WINS server is installed.

Step 2 Verify that the DNS server is installed.

Step 3 Check Apache log files for additional errors.

To verify that the WINS server is installed:

1 Click Start.

2 Point to Settings.

3 Click Control Panel.

4 Click Add/Remove program.

5 Click Add/Remove Windows Components.
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6 Click Networking Services.

7 Click Details.

8 Verify that the WINS Server check box is selected and properly configured on 
the network. Also verify that it is functioning.

To verify that the DNS server is installed:

1 Click Start.

2 Point to Settings.

3 Click Control Panel.

4 Click Add/Remove program.

5 Click Add/Remove Windows Components.

6 Click Networking Services.

7 Click Details.

8 Verify that DNS is installed, and that the DNS servers (or server) are 
connected and working on the network.

To view Apache log files for additional errors:

From a text editor, open the Apache log files.

The default files are in c:\Program Files\Peregrine\Common\Apache2\logs.
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Troubleshooting Apache Web server for UNIX

If you are having trouble with the Apache Web server for UNIX, follow these 
instructions.

The Web server is not responding
If the Apache Web server is not responding, check the network setup.

To check the network setup:

1 Make sure the port that Apache uses is not in use by another network service.

Note: Apache uses port 80 by default. You can change this by using the Port 
directive in the httpd.conf file. Use the netstat command to list all 
ports being listened to after shutting down Apache.

$ /etc/init.d/oaactl stop

$ netstat -a | grep 80

2 Make sure the IP address and hostname of the server are configured 
correctly. If so,

The Ping command successfully gets a response from the server.

The nslookup hostname displays the correct mapping from the hostname 
to the IP address.

The telnet hostname 80 successfully connects to the server. 

$ /usr/sbin/ping hostname -n 5

$ telnet hostname 80

Trying...

Connected to hostname

Escape character is '^]'.

View Apache log files for advanced errors
If you are having trouble with the Apache Web server, view the log files.

To view Apache log files for advanced errors:

From a text editor, open the Apache log files.

The default Apache log files are in: 
<base install directory>/peregrine/common/apache2/logs.
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Troubleshooting the IBM HTTP Server

The BI Portal installer creates duplicate alias entries in the IBM HTTP Server 
when you install more than one Peregrine OAA Platform application on 
WebSphere.

Duplicate entries can also occur if you reinstall BI Portal or install another 
Peregrine OAA Platform application on a system that formerly had BI Portal 
installed on it.

Remove any duplicate alias entries from the IBM HTTP Server httpd.conf 
file.

Troubleshooting Tomcat

Before you can troubleshoot problems on Tomcat, you must become 
familiar with starting and stopping Tomcat on your operating system. You 
also need know where the Tomcat log files are located.

To start/stop Tomcat on Windows

1 Click Start.

2 Click Programs.

3 Click Administrative Tools.

4 Click Services.

5 Locate the PeregrineTomcat service in the list and start/stop/restart it.

To start/stop Tomcat on UNIX

$ /etc/init.d/oaactl <start/stop/restart>

The following table contains the default Tomcat log file locations.

Operating system Default Tomcat log files location

Windows C:\Program Files\Peregrine\Common\Tomcat4\logs

UNIX /<installed base directory>/peregrine/common/tomcat4/logs
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Check for Tomcat port conflicts
The following table displays the default Tomcat port usage.

In the Tomcat log file stderr.log, the following line indicates the currently 
succeeded AJP13 port being used:

[INFO] ChannelSocket - -JK2: ajp13 listening on tcp port 8009

To check for Tomcat port conflicts:

1 Stop the Tomcat service.

2 Use netstat -a to list ports being listened on. Check for port conflicts.

3 Make necessary modifications to Tomcat port configuration or disable (or 
modify) the conflicting service. Additional information about Tomcat is 
available at http://jakarta.apache.org/tomcat/.

Checking for Port Conflicts: an example
Check for entries where the Proto value is “TCP” and the State is “Listening.” 
For example, the following output from the netstat -an command shows that 
ports 80, 8009, 8025, 12670, and 1585 are in use:

Active Connections 

Proto Local Address Foreign Address State
TCP 0.0.0.0:8 0 0.0.0.0:0 LISTENING
TCP 0.0.0.0:8009 0.0.0.0:0 LISTENING
TCP 0.0.0.0:8025 0.0.0.0:0 LISTENING
TCP 0.0.0.0:12670 0.0.0.0:0 LISTENING
TCP1 0.2.3.154:1032 66.163.173.77:80 ESTABLISHED
TCP1 0.2.3.154:1342 10.2.3.154:12670 ESTABLISHED
TCP1 0.2.3.154:1585 0.0.0.0:0 LISTENING
TCP1 0.2.3.154:1585 10.2.0.112:139 ESTABLISHED

Port number Tomcat service

8005 Tomcat Administration

8009 Tomcat AJP13 Worker Port
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Check for Tomcat errors
Make sure that you are working with clean files.

To ensure a clean environment for troubleshooting:

1 Shutdown the Apache and Tomcat services.

2 Remove all log files.

3 Restart the Apache and Tomcat services. 

4 Use a browser to connect to the Web server. 

File mod_jk.log
This file contains log information regarding the out-of-process TCP 
connection between the Apache Web server and Tomcat.

This file is empty when there are no errors. It contain hints about connection 
failures when the AJP13 port is in conflict with another service, or when the 
Tomcat mod_jk connector is configured incorrectly.

File stdout.log
The following is a normal output of this log file:

Look for the following in this file during an error:

Archway Servlet is not instantiated.

Bootstrap: Create Catalina server
Bootstrap: Starting service
Starting service Tomcat-Standalone
Apache Tomcat/4.1.12
Instantiating Archway Servlet...
2002-12-10 12:22:13,079 INFO  [main]  - Using application preferences in 
/C:/Program Files/Peregrine/Common/Tomcat4/webapps/oaa/WEB-INF/local.xml
2002-12-10 12:22:13,119 INFO  [main]  - Using default preferences in /C:/Program 
Files/Peregrine/Common/Tomcat4/webapps/oaa/WEB-INF/default/archway.xml
2002-12-10 12:22:13,200 INFO  [main]  - Using default preferences in /C:/Program 
Files/Peregrine/Common/Tomcat4/webapps/oaa/WEB-INF/default/common.xml
2002-12-10 12:22:13,240 INFO  [main]  - Using default preferences in /C:/Program 
Files/Peregrine/Common/Tomcat4/webapps/oaa/WEB-INF/default/logging.xml
2002-12-10 12:22:13,270 INFO  [main]  - Using default preferences in /C:/Program 
Files/Peregrine/Common/Tomcat4/webapps/oaa/WEB-INF/default/themes.xml
2002-12-10 12:22:13,280 INFO  [main]  - Using default preferences in /C:/Program 
Files/Peregrine/Common/Tomcat4/webapps/oaa/WEB-INF/default/xsl.xml
Bootstrap: Service started
186 Appendix A—Troubleshooting the installation 



Installation Guide
The webapps location is incorrect.

Bootstrap service failed to start.

File stderr.log
The following is a normal output of this file:

Look for the following problems in this file during an error:

catalinaLoader was not created or is pointing to an incorrect location.

ChannelSocket - JK2: ajp13 failed to connect or is connecting on an 
incorrect port number.

JkMain is not using the right jk2.properties.

File localhost_log.<date>.txt
There should not be any Java errors in this log file. This file logs application 
manager activity in deploying Peregrine OAA Web applications.

Troubleshooting OAA

If you are having trouble with your Peregrine OAA Web application, verify 
your application’s back-end server and view the OAA logs.

OAA back-end configuration
Make sure that the Peregrine OAA application is connecting to the right 
back-end server and that it is currently functional.

To check back-end configuration:

1 Browse to http://hostname/oaa/admin.jsp.

2 Login as System and no password (providing this has not changed after 
installation).

3 From the Administration module, verify the connection status of the listed 
adapters.

Created catalinaLoader in: C:\Program Files\Peregrine\Common\Tomcat4\server\lib
[INFO] Registry - -Loading registry information
[INFO] Registry - -Creating new Registry instance
[INFO] Registry - -Creating MBeanServer
 [INFO] ChannelSocket - -JK2: ajp13 listening on tcp port 8009
[INFO] JkMain - -Jk running ID=0 time=0/120  config=C:\Program 
Files\Peregrine\Common\Tomcat4\conf\jk2.properties
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log
4 Click on the target for the back-end server, for example, sc.

5 Verify that the host and port for the back-end server are correct.

OAA log files
The following table lists the default file locations of the Peregrine OAA log 
files.

Make sure that the log files contain:

A listing of installed OAA components and their version numbers.

A correct listing of registered packages.

An Archway initialization complete statement.

If the file contains Java ClassNotFound exceptions, check to see if all the 
required jar files are found.

Troubleshooting WebSphere

Duplicate alias entries can occur from the IBM HTTP Server httpd.conf file 
during a WebSphere installation. If this happens, the Admin form at 
http://hostname/oaa/login.jsp does not render.

Remove duplicate Alias /oaa lines from the httpd.conf file under the conf 
directory of the IBM HTTP or Apache web server. You want only one of the 
following:

Alias /oaa "C:\WebSphere\AppServer\installedApps\oaa.ear\portal.war"
Alias /oaa "C:/WebSphere/AppServer/installedApps/oaa.ear/portal.war"

Troubleshooting ServiceCenter server

If you are having trouble with the ServiceCenter server:

Step 1 Check the ServiceCenter Auth code and port setting.

Operating system Default Peregrine OAA log files location

Windows C:\Program Files\Peregrine\Common\Tomcat4\bin\archway.log

UNIX /<installed base directory>/peregrine/common/tomcat4/archway.
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Step 2 Check the ServiceCenter log.

Before you troubleshoot problems, you must become familiar with starting 
and stopping the ServiceCenter server on your operating system. You also 
need to know where the ServiceCenter log files are located.

To start/stop ServiceCenter on Windows:

1 Click Start.

2 Click Programs.

3 Click Administrative Tools.

4 Click Services.

5 Locate the PeregrineServiceCenter service in the list and start/stop/restart it.

To start/stop ServiceCenter on UNIX:

$ /etc/init.d/oaactl <start/stop/restart>

The following table contains the default ServiceCenter log file locations.

Check ServiceCenter Auth code and port setting
The following table contains the ServiceCenter setting file location.

To check the ServiceCenter Auth code and port setting:

1 Make sure the auth code set by the auth: tag is correct.

2 Make sure the port setting for system: matches the setting for the OAA 
back-end.

Operating system Default ServiceCenter log files location

Windows C:\Program Files\Peregrine\ServiceCenter\sc.log

UNIX /<installed base directory>/peregrine/servicecenter/sc.log

Operating system ServiceCenter setting file location

Windows C:\Program Files\Peregrine\ServiceCenter\RUN\sc.ini

UNIX /<installed base directory>/peregrine/servicecenter/RUN//sc.ini
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View ServiceCenter log
To view the ServiceCenter log:

1 View the log file for auth code expiration errors.

2 View the log for resource attachment errors.

3 Refer to ServiceCenter Administration Guide for further troubleshooting if 
required.

Using ServiceCenter on Oracle
When using ServiceCenter on Oracle as the back-end database, 
personalization does not display pages correctly. From ServiceCenter, you 
must map the giComponentUsers table to Oracle. 

To map the giComponentUsers table to Oracle:

1 Open the ServiceCenter client.

2 Log in as Administrator.

3 Add a sqlsystemtables record.

a Click the Toolkit tab to open the Database Manager dialog box.

b Type sqlsystemtables in the File field and click Search.

c Check the Map as Blob flag.

4 Go to the sqlmapping table and delete all records for giComponentUsers 
table.

5 Map the giComponentUsers table to Oracle.

Contact your ServiceCenter Administrator for more information on 
updating ServiceCenter table definitions.

Troubleshooting BI Portal 

Error messages contain a dash: “(-error_number)”
Error messages that contain a dash (-error_number), such as -2006 and -52, 
may appear in the Connect.it RDS logs. To correct the problem, follow these 
steps on the RDS server:
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1 Reboot the RDS server.

2 Make sure the valid Connect-It license file, license.txt, resides in the 
Connect-It root directory.

3 Make sure that tnsname bi_repo has been created in Oracle environment. If 
using DB2 or SQL Server, make sure that the bi_repo system DSN has been 
defined for the ODBC data source.

4 Reconfigure the RDS scenario from the Connect.It service console. Test all 
the connections by pressing the Test button when displayed.

No valid synchronized records 
No valid records have been synchronized between ServiceCenter and the 
RDS database through Connect.It. 

To synchronize, follow these steps on the RDS server:

1 Stop the rds scenario from the Connect-It Service Console.

2 Verify these are no errors that contain a dash (-) in the 
ConnectIt\bin32\CIT_RDS.log file, as described in the section Error messages 
contain a dash: “(-error_number)” on page 190. If such errors have occurred, 
follow the steps in that section to correct the problem.

3 Delete the .ini file in the rds\cit directory.

4 In Windows click Start -> Run and enter cmd to open the DOS command 
prompt.

5 If the RDS is installed in the C:\Program Files\Peregrine\rds directory, enter 
the command: 
cd c:\program files\peregrine\rds\common\bin

6 Enter the command rds_init.

7 Restart the RDS scenario from the Connect-It Service Console.
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The BI Portal "Application Session has a timed out" or "Invalid user 
account" error

1 Verify that all the reporting users are populated in the operator_d table in the 
RDS database: Log in to the RDS_DBA user account and run the following 
SQL statement in the proper RDBMS client program:
select name,z_rdsoperator_d from operator_d order by name

2 If there are no valid reporting user names in operator_d, follow the steps to 
correct the RDS initial synchronization error in the section No valid 
synchronized records on page 191.

3 Make sure the database connection is established as bi_repo tnsname or as a 
system DSN ODBC data source.

4 Log in to the RDBMS as user RDS_DBA and run the following SQL 
statement in the proper RDMS client program:
delete * from rds_sec_sync

5 Click Reset Server in the BI Portal Admin page.

6 Open the Administration Console 6.0 program from the Business Objects 
program folder on the Reporting Server machine.

7 Click WILoginServer and click Refresh.

No Business Objects documents or reports are viewable from BI 
Portal

1 On the BI Reporting Server, make sure there are files with the extension .wid 
in the following directory:
C:\Program Files\Business Objects\BusinessObjects Enterprise 6
\nodes\BO_Server_Host_Name_XXX\Cluster_Name_XXX\storage
\user\Peregrine_Designer (where Business Objects is installed on the C 
drive).

2 On the BI Portal server, modify the file 
C:\Program Files\Peregrine\common\Tomcat 
4.1.24\webapps\oaa\WEB-INF\etc\BI\rds\docstatus.properties as follows: 
change the line 
published=true 
to 
published=false

3 Click the Reset Server button on the BI Portal Admin page.
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Error on BI portal: "The Reporting Server cannot be accessed at 
this time. Please contact your Reporting Server Administrator."

There are two possible causes:

Cause 1: 
You have not started the Business Objects system and you need to start the 
Business Objects system. Perform one of the following:

Use WebIntelligence Notify, a utility that can be used to start and stop 
WebIntelligence and check its status. Right-click the Notify icon on the 
Task Bar and select the Start WebIntelligence command from the pop-up 
menu. Or..

Click Start -> Setings -> Control Panel

Cause 2 
WebIntelligence is started but you have an internal CORBA error. In this 
case, stop and re-start both the Web server and the entire Business Objects 
system.

BI portal error: "Unable to access the document. Please contact 
your Reporting Server Administrator"

There are three possible causes.

Cause 1 
An error occurred while requesting document from Business Objects 
storage.

Cause 2 
Either the connection to the specified universe domain, or the universe 
domain itself, is invalid.

Perform the following steps:

1 Launch Supervisor.

2 Click Tools -> Repository.

The Repository Management dialog box is displayed.

3 Click the document domain.
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4 Click the Test button to check if the connection to the document domain is            
valid.

5 Click the Integrity button to check if the document domain itself is valid. To 
identify or repair errors, click Scan to display the Scan and Repair dialog box. 
Also, you can click Scan to report the errors, or you can click Repair to fix            
them.

Cause 3
You cannot make a connection to the universe domain, either because there 
is no network connection, or because the server on which the universe 
domain is located is down. To correct this problem verify the network 
connection by "pinging" the server. If the network is running properly, the 
database administrator should then use database middleware (such as Net8 
for Oracle) to check if there is any response from the repository database.

BI portal Errors: "Error: View does not exist. Please contact your 
Reporting Server Administrator"

The problem is access to the application database. The connection you 
selected is unavailable or no longer valid in the repository. The server cannot 
open the connection and activate the database mode system through it.

To correct this proble make sure your application database is still working.
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BI Portal Log Files

BI Portal creates the following log files that can assist yoiu in troubleshooting:

Business Objects log file:
C:\Program Files\Peregrine\BI\logs biconfig.log

RDS log file:
C:\Program Files\Peregrine\RDS\logs

Connect-It log file:
C:\Program Files\Peregrine\ConnectIt\bin32

BI Portal log file:
C:\Program Files\Peregrine\BI\logs biconfig.log

BI Portal log file created after configuration:
C:\Program Files\Peregrine\Common\Tomcat4\bin \archway.log
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